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Preface

Welcome to the STRATEGY™ 4.5 Installation Guide. This preface provides the following
information:

m What you'll find in this guide

m Whereto find additional information

m  How to find documentation online

m  How to contact the documentation team to provide feedback about this guide

Adobe Acrabat (.pdf) versionsof the STRATEGY guidesareavailableonthe STRATEGY CD-ROM.
Viewing and printing the documents requires Adobe Acrobat Reader. If necessary, you can download
it at no cost fromwww.adobe.com, or you caningtal it fromthe STRATEGY CD-ROM. Click Browse
the CD-ROM, and open the Toolsfolder. Use the Adobe Acrobat Reader online Help to get answersto
your questions about viewing and navigating the documents.

About This Guide

Chapter 1, “Technical Support,” contains ShowCase contact information.

Chapter 2, “Release Overview,” contains STRATEGY 4.5 enhancements and rel ease notes.
Chapter 3, “Environment Requirements,” contains hardware and software prerequisites.
Chapter 4, “Passwords and Licensing,” describes passwords, licensing, and PC naming.
Chapter 5, “Installing Server Software,” covers the i Series® (AS/400®) software installation.

Chapter 6, “Installing and Uninstalling PC Software,” covers the PC software installation, including
network installations.

Chapter 7, “Setting Up Silent Installations,” covers silent installations.
Chapter 8, “Setting Up an 0DBC Data Source,” explains how to configure ODBC data sources.

Chapter 9, “Connecting to the iSeries (AS/400),” explains how to access an iSeries (A S/400) with
STRATEGY PC software.

Appendix, “Installing Esshase/400 Sample Applications,” explains how to set up the Essbase sample
applications and databases.



Additional Resources

m  Forinformation about STRATEGY iSeries (A S/400) software (Warehouse Manager Server and
Essbase/400) maintenance, see the STRATEGY 4.5 Administrator’s Guide.

m  For information about product features unrelated to the STRATEGY installation, seethe online
Help in each application or the Quick Start guides on the SPSS Support Web site at
http://support.spss.com. After you log on, click Documentation and then STRATEGY Manuals.

m  For information about upgrading to STRATEGY 4.5, see the STRATEGY 4.5 Upgrade Guide
at http://support.spss.com/upgradeinfol.

Finding Documentation Online

You can view and download additional documentation after youinstall STRATEGY. You must have
an Internet connection to view the documents. From the Windows Start menu, choose:
Programs

ShowCase STRATEGY 4.5
Documentation

Send Us Your Comments

Your comments are important to us. Please tell us what you think about the STRATEGY
documentation by contacting:

Documentation Team

ShowCase, adivision of SPSS
4115 Highway 52 NW, Suite 300
Rochester, MN 55901-0144

Tel: (507) 288-5922

E-mail: docfeedback@spss.com

Customer Service

If you have any questions concerning your shipment or account, contact your local office, listed on
p. v. Please have your serial number ready for identification when calling.


http://support.spssshowcase.com/upgradeinfo/
http://support.spssshowcase.com/upgradeinfo/
http://support.spssshowcase.com
http://support.spssshowcase.com
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Chapter

Technical Support

Contacting Support

Phone. Our goal is to provide one-on-one technical support. However, based on the complexity
and/or frequency of calls, you may reach our phone-mail system. Leave your name, company
name, and telephone number, and a support member will call you back.

Fax. Send your name, company name, and telephone and fax numbers along with the detail s of your
reguest and the name of the product with which you need assistance.

Internet. Enter your request on the Support Web site. You can also use the site to find
documentation, download patches, open a case, and participate in the customer forum. See
“Internet Support” below.

E-mail. Include your name, e-mail address, company name, the feature that you have a question
about, and your question or request.

Internet Support

Table 1-1
Internet addresses

Site Address

Support Web site http://support.spss.com

ShowCase, adivision of SPSS, Web site | http://www.spssshowcase.com

Documentation team e-mail docfeedback@spss.com

The following information is on the SPSS Support Web site at http://support.spss.com. To access
STRATEGY support, click the ShowCase Division Products link.

Frequently asked questions. Find answers to some of the most common questions.
Frequently used resolutions. View the top resolutions of the week, month, and all time periods.

STRATEGY manuals. View and download the latest documentation, including the I nstallation Guide,
Administrator’s Guide, Upgrade Guide, and Quick Sart guides.

Technical bulletins and newsletters. View and download technical bulletins or browse the
newsl etter archive for technical issues.

Patches. Download patches for all supported STRATEGY products.

Case information. Open a support case and view the status of your cases.


http://support.spssshowcase.com
http://support.spssshowcase.com/
http://www.spssshowcase.com
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STRATEGY customer forum. Network with other maintenance customers in this discussion group.

Contact information. Find current phone and fax numbers and e-mail addresses for North America,

Europe, and Japan/Asia Pacific.

North American Support

Table 1-2

North American services and support information

Topic Phone Fax E-mail

North American support (507) 288-5922 :

(relational products) Option 2, then option 1 (507) 287-2809 | scsupport@spss.com
North American support (507) 288-5922

(multidimensional products) Option 2, then option 2 (507) 287-2809 | scsupport@spss.com
Product training - .

and consulting services (312) 261-6544 (847)779-6544 | TrainingServices@spss.com

European Support

Table 1-3

European support information
Country Language Phone Fax E-mail

Austria German 49 89 48 9074 333 49 89 44 83115 suppge@spss.de
Belgium Dutch 3224771700 3224740363 eursupport@spss.com
Belgium French 3224771701 3224740363 eursupport@spss.com
Belgium German 3224771702 3224740363 eursupport@spss.com
Denmark English 45 361 58731 3224740363 eursupport@spss.com
France French 33155212532 3224740363 eursupport@spss.com
Germany German 49 89 48 9074 333 49 89 44 83115 suppge@spss.de
Italian and

Italy English 39 0280 663036 3224740363 eursupport@spss.com
Luxembourg French 3224771703 3224740363 eursupport@spss.com
Switzerland French 41 227 100034 3224740363 eursupport@spss.com
Switzerland German 49 89 48 9074 333 49 89 44 83115 suppge@spss.de
The Netherlands | Dutch 31 205 82 94 96 3224740363 eursupport@spss.com
United Kingdom | English 44 1483 719 202 441483 719290 | support@spss.co.uk
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Japan and Asia Pacific Support

Technical Support

Table 1-4
Japan and Asia Pacific support information
Region Phone Fax E-mail
Japan and Asia Pacific | 81 35466 7187 | 81 3 5466 5622 | jpscsupport@spss.com
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Release Overview

For the latest release notes, see the 4.5 Readme (screadme.doc). If you are upgrading to
STRATEGY 4.5, read the STRATEGY 4.5 Upgrade Guide. See Table 2-1.

Table 2-1
Supplemental documentation

Documentation L ocation Instructions

From the Start menu, choose
STRATEGY 4.5 ReadMe Documentation Web page Programs > ShowCase
STRATEGY 4.5 >Documentation.

After you log on to the ShowCase
division support site, click
Documentation >STRATEGY
Manuals.

STRATEGY 4.5 ReadMe http://support.spss.com

STRATEGY 4.5 Upgrade Guide| http://support.spss.com/upgradeinfo | No logon required.

Enhancements
General Enhancements

Support of Microsoft, Oracle, and Domino Data Sources

You can use Warehouse Builder to pull datafrom Microsoft Access and Excel, Oracle on AlX,
Windows NT or Windows 2000, Lotus Domino, and SQL Server. You can also access Oracle data
on Windows NT or Windows 2000 and L otus Domino data via Query, Report Writer, and
Enterprise Reporting. For setup instructions, seethe Non-DB2 Data Source guides. To accessthem
from the STRATEGY 4.5 menu, choose Documentation.

Enterprise Reporting Enhancements

There have been significant Enterprise Reporting enhancements.
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Orion Application Server

If you are acurrent Enterprise Reporting user, you will use Orion Application Server instead of IBM
HTTP Server or Websphere. Orion configuration is automated during installation.

SPSS Web Deployment Framework

Enterprise Reporting has been redesigned on top of anew, centralized, Java-based Web application
framework. This new architecture uses a database repository for all objects and metadata, thereby
simplifying administration. It also provides arobust set of new content management, security,
personalization, and administration services that will result in new capabilities for consumers and
publishers and faster, easier deployment of Web applications for administrators.

Unstructured Content

Enterprise Reporting 4.5 allows organizations to manage all types of enterprise information,
including query and report definitions, query and report output, documents, images, manuals, etc.
All of theinformation is stored in a central library that is accessible viaabrowser. This greatly
simplifies the information landscape, making it easy for users to find exactly what they need.

Expiration Dates

Enterprise Reporting 4.5 enables information publishers to assign expiration dates to repository
content. Expiration dates ensure that access to information is restricted as soon as information
becomes obsolete. This ensures that everyone who accesses the library is viewing the current and
correct version of every document.

Metadata Attributes

All information stored in the Enterprise Reporting 4.5 repository is cataloged by attribute, such as
author, date, title, abstract, document type, and expiration date, ensuring that consumersreceivethe
context that they need to easily find relevant content. In addition, the Enterprise Reporting solution
providesacustomizablelibrary or catalog structure so that publishers can categorizeinformationin
whatever way makes sense in their organization. The library itself uses a folder-like hierarchy to
store information, making it easy and intuitive to categorize and locate content and enabling users
to model the content hierarchy after the structure of their business.

Security Attributes

Enterprise Reporting 4.5 incorporates a security model integrated with i Series user and group
profiles. Publishers can assign read, write, and administrative privileges, which can be granted on
auser or group basis directly from a browser or from within Query or Report Writer when
publishing information. Security attributes can be assigned globally to categories of information or
users and to individual pieces of content. This ensures a flexible and granular security model that
ensures that information stored in the central library is accessible only by those entitled to view it.
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Search

Enterprise Reporting 4.5 enablesinformation consumersto locate the right information quickly by
conducting repository searches. Searchable attributes includetitle, abstract, author, and keywords.

Browser-based Publishing

Enterprise Reporting 4.5 enables information publishersto easily post information, including
query and report definitions and result sets and unstructured content to the central library directly
from their Web browser. In addition, users with appropriate authorities can edit content
attributes, move or delete content, and modify the categorization of content all from asimple
browser interface.

Personalization Services

Each Enterprise Reporting user is greeted with a persona home page. Users can customize the
home page with direct linksto frequently-used documents. They can also directly accesstheresults
of previously run reports, maintain personal contact information, and directly access content they
own. The home page provides direct access to publishing and administrative tools for authorized
users, and administrators can further customize the system to include shortcuts to other Web-based
tools such as Analyzer for the Web or Web-based e-mail systems.

Customization Services

Enterprise Reporting 4.5 provides support for customized “flavors’ that enable organizations to
quickly and easily modify the look and fedl of the application to match their organization’s
corporate image or Web sites.

Browser-based Administration

Enterprise Reporting 4.5 provides aWeb-based administrativeinterface that enablesadministrators
to efficiently manage a number of system attributes via a browser and from remote locations.
Administrators can manage user authorities, build and manage the content hierarchy and security,
specify server settings and attributes, and audit user activities.

LDAP

Enterprise Reporting 4.5 can be configured to use the Lightweight Directory Access Protocol
(LDAP) to authenticate users accessing the application.

Additional Enterprise Reporting Documentation

The following documents provide information on product installation, configuration, and
Help access.
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STRATEGY Installation Guide

See Chapter 5 for instructions on installing Orion Application Server for Enterprise Reporting.

Enterprise Reporting Administrator’s Guide

Migrate existing objects and documents, configure Enterprise Reporting, and set up security. Before
youinstall STRATEGY, you can find thisguide at http://support.spss.com. Log on to the ShowCase
division support site, click Documentation, and then STRATEGY Manuals.

After you install STRATEGY, find the guide on the Documentation Web page. From the Windows
Start menu, choose:

Programs
ShowCase STRATEGY 4.5
Documentation

Browser Help and Tutorials

After you set up Enterprise Reporting, use the Help and tutorials to navigate Enterprise Reporting
and get step-by-step instruction. Two Help systems are available from your browser: the SPSS Web
Deployment Framework (SWDF) Help and the Enterprise Reporting Hel p. Each system comeswith
its own table of contents, index, and tutorials.

SWDF Help. SWDF is designed to work with a broad range of applications, some of which have
specific requirements for publishing and managing data. As aresult, the SWDF Help is a general
Help system that covers basic browser tasks, such as using the Home page and locating and viewing
documents using the Catal og. Availability of specific features documented here may vary by site.
For example, categories, passwords, URLS, security settings, and other features are configured
locally at each site by the administrator and may vary slightly depending on the application
deployed within the framework.

To access the SWDF Help:

» Click the Help icon from any of the main SWDF pages such as Home, Catalog, or Publisher.
Working with SPSS Web Content appears in the browser title bar.

To access the SWDF Tutorial:
» From the SWDF Help table of contents, click Additional Resources, and then click any of the

tutorial links.

Enterprise Reporting Help. Enterprise Reporting is an application designed to work within the SPSS
Web deployment framework. The Enterprise Reporting application has a Help system specific to
Enterprise Reporting tasks and features.
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To Access the Enterprise Reporting Help:

» Click the Help icon from an Enterprise Reporting screen such as Submitted Reports, or click Help
when you open an Enterprise Reporting document in your browser (for example, aquery or report).
Working with Enterprise Reporting appears in the browser title bar.

To access the Enterprise Reporting Tutorial:

» From the Enterprise Reporting Help table of contents, click Additional Resources. Then click any
of the Enterprise Reporting tutorial links.

Home Site Enhancements

To use Enterprise Reporting and/or Analyzer for the Web 4.5 with your existing STRATEGY
Home Site, see Migrating Home Site to STRATEGY 4.5 to update the STRATEGY Home Site
links. You can access this document on the Documentation Web page from the STRATEGY 4.5
menu.

Documentation Enhancements

You can view and download additional documentation after you install STRATEGY. You must
have an Internet connection to view the documents.

To launch the Documentation Web page:

» From the Windows Start menu, choose:

Programs
ShowCase STRATEGY 4.5
Documentation

Esshase/400 Enhancements

STRATEGY 4.5 supports Hyperion Essbase 6.1 features and functions.

MaxL Command Interface

Essbase/400 supports the MaxL command interface. Users can administer Essbase/400 Server
from an i Series command line using MaxL/400. Traditionally, ESSCM D/400 has provided
functionality consistent with the PC ESSCMD (ESSCMD and ESSCMDW). Hyperion has
positioned MaxL as the next generation of ESSCMD.

While ESSCMD/400 and the ESSCMD API continue to be supported, many new Essbase
features are accessible only through the MaxL/400 interface. Thus, we recommend using
MaxL /400 to automate and maintain your Essbase/400 Server. Users can use MaxL in script,
command line, or interactive mode. For help with specific MaxL commands, see the Hyperion
MaxL User’s Guide. ESSCMD/400 users should refer to the STRATEGY Administrator’s Guide.
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New Server Commands

RUNMAXLSTM command. Start the command line interface to issue MaxL/400 commands from an
0S/400 command line.

ESSMSH command. Process an input or script file containing MaxL statements.

For more information about these commands, see the STRATEGY Administrator’s Guide. For help
with specific MaxL commands, see the Hyperion MaxL User’s Guide.

J.D. Edwards (JDE) Enhancements

Non-iSeries Profile Sign-0On

Previously, JDE OneWorld users needed an OS/400 user profile for STRATEGY to recognizetheir
environment information. The new SETIDEOWA command enables STRATEGY to recognize
environment information for OneWorld users who don’t have an i Series (A S/400) user profile.

Non-iSeries profiles cannot be used with Warehouse Builder, Warehouse Manager Client, or
Enterprise Reporting. For more information about this command, see the STRATEGY
Administrator’s Guide.

Editing ShowCase.cfg to Use an Alternate F0094 File

The FO094 file in JDE OneWorld usually containsthe Master Library List data. STRATEGY JDE
OneWorld integration uses thisfile to set the library list upon connecting to the database through
the Web or application interface. Occasionally, the JIDE OneWorld environment administrator may
choose to omit the FO094 file in the OneWorld Client environment and use information in a Client
Access Data Source. Since STRATEGY cannot determine the data source used for the library lists,
anew method uses an alternate file (which must contain FO094 data). This method involves
duplicating the FO094 file and editing the configuration file (showcase.cfg).

To set up this dternate configuration, see the STRATEGY Administrator’s Guide.

User Defined Codes (UDC)

During theinitial IDE system setup, an administrator will customize descriptions for users based
on category codes that exist with the system. A user can select these UDC customized descriptions
inthe STRATEGY columns display. In STRATEGY 4.5, UDC customized descriptions are
available in Query, Report Writer, and when running interactive reports via a browser using
Enterprise Reporting.
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Multiple Library List Environments

STRATEGY retrieves library list environments that are set up in the JDE environment. A user
who has been set up in the JDE system to have multiple library list environments has the option
of selecting an environment on the initial connection or having one set as the default. In
STRATEGY 4.5, an enhancement allows the prompting for library list environments when
running interactive reports via a browser using Enterprise Reporting. Another enhancement
allows prompting for library list environmentsiif the environment is defined for the users group
instead of the individua profile.

Query and Report Writer Enhancements

The Save to ShowCase Server dialog boxes have been enhanced to allow you to specify document
properties displayed to Enterprise Reporting users in the browser. These document properties
include general information (for example, title and description) and read/write security settings.

Figure 2-1
New Save to ShowCase Server dialog box

Location General ISecurit_l,ll

Title: ISaIes.dbq

Lithor: IJ oe Smith

Langgage:l
Kewwaords: I j
Description:
Template: IDefauIl vl
' Mever

Expiration -
Date: @ Egiies @ I‘IDH1 200, v|

Save I LCancel | Help |

Hyperion Analyzer and Hyperion Web Client Enhancements

For enhancement information, see the Hyperion documentation accompanying your Hyperion
Analyzer CD.
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Warehouse Builder Enhancements

The STRDD (Start data distribution) and SBMDD (Submit data distribution) commands how run
Warehouse Builder distribution sets by set (object) name (OBINAME).

For example, the following commands run the distribution set named Sales:

STRDD OBJNAME('Sales’) OBJID(*NONE)
or
STRDD OBJNAME('Sales))

You can still run the commands by set (object) ID (OBJID). For example, the following commands
run the distribution set with an 1D of 51:

STRDD OBJNAME(*OBJID) OBJID(51)
or
STRDD OBJID(51)

If you are running sets from your own CL programs with the object IDs hard-coded in either the
STRDD or SBMDD command, and you restore Warehouse Builder information into a server library
aready containing distribution definitions, the object IDs of the distribution sets will change. To
avoid this problem, use the abject name of the distribution set in the STRDD or SBMDD commands.
See the STRATEGY Administrator’s Guide, for more information.

Warehouse Manager Server Enhancements

Installation

In STRATEGY versions prior to 4.0, the AOS and Warehouse Manager Server (SCSERVER) used
two separate ports. However, with versions 4.0 and later, the AOS port is incorporated into the
Warehouse Manager Server port. If you are upgrading to version 4.5 and you use Analyzer, you can
retain both ports, but future STRATEGY releases will support only one port. For information, see
“Warehouse Manager TCP/IP Port Configuration” on p. 34.

Authority Requirements Removed

The STRSCSVR command now requires only *JOBCTL authority. The ENDSCSVR command now
requires only *JOBCTL and *ALLOBJ authority.

New Server Commands

INSTORI command. If you are installing Enterprise Reporting, you must install Orion Application
Server, available during server installation. If you defer Orion installation at that time, you can use
the INSTORI command to install it later with the STRATEGY CD. The command requires
QSECOFR or equivalent authority (*ALLOBJ, *IOSYSCFG, *SAVSYS, *JOBCTL, and *SECADM
special authorities are needed).
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STRORI command. Starts Orion Application Server. Requires *JOBCTL authority.
ENDORI command. Ends Orion Application Server. Requires *JOBCTL and *ALLOBJ authority.

For moreinformation about the Orion Application Server commands, see the Enterprise Reporting
Administrator’s Guide.

SETJDEOWA command. Previously, JDE OneWorld users needed an OS/400 user profile for
STRATEGY torecognizetheir environment information. The new SETIDEOWA command enables
STRATEGY to recognize environment information for OneWorld userswho do not have aniSeries
(A'S/400) user profile. For more information, see the STRATEGY Administrator’s Guide.

MIGSCREP command. The MIGSCREP command migrates STRATEGY 3.0, 3.5,4.0, or 4.1
Information Directory objects and documentsto the STRATEGY 4.5 Web deployment framework.
If you defer migration during Warehouse Manager Server or Orion Application Server installation,
usetheiSeries MIGSCREP command to schedule the migration. The command requires QSECOFR
or equivalent authority (*ALLOBJ, *IOSYSCFG, *SAVSYS, *JOBCTL, and *SECADM special
authorities are needed).

Release Notes

For the latest Release Notes, see the 4.5 Readme (screadme.doc). You can find the Readme in the
following locations:

m At http://support.spss.com. After you log on to the ShowCase division support site, click
Documentation, then STRATEGY Manuals.

m After installation, you can find it in the root folder in which you installed STRATEGY client
components.

m After installation, you can find it on the Documentation Web page:
» From the Windows Start menu, choose:
Programs

ShowCase STRATEGY 4.5
Documentation

General Release Notes

APPC communications protocol is no longer supported.
Enterprise Reporting Release Notes

Migrating to Enterprise Reporting 4.5

If you are anew or current Enterprise Reporting user, you must install Orion Application Server,
an integrated application server and Web server package. This server will replace your existing
HTTP server and WebSphere. You caninstall the Orion server when youinstall the server software,
or you can install it later with the INSTORI command.
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If you used Enterprise Reporting in STRATEGY 3.0, 3.5, 4.0, or 4.1, you must migrate the
objects and documents in your current Information Directory to the STRATEGY 4.5 Web
deployment framework. You won't have access to your existing Enterprise Reporting objects until
you migrate.

For information, see the Enterprise Reporting Administrator’s Guide. Before you install
STRATEGY, you can find this guide at http://support.spss.com. After you log on to the ShowCase
division support site, click Documentation, then STRATEGY Manuals.

After you install STRATEGY, you can find the guide on the Documentation Web page.

From the Windows Start menu, choose:

Programs
ShowCase STRATEGY 4.5
Documentation

Reports Manually Copied to Enterprise Reporting

Reports must be saved to the server through Query, Report Writer, or the Enterprise Reporting
Publisher in the browser to appear in Enterprise Reporting. Manually copying reports via
WRKLNK, Client Access, or FTPisnot supported. Also, reports previously copied will not appear
in Enterprise Reporting.

Submitting a Dynamic Report with Prompting

m  Prompts are not supported if areport references an external data source not mapped in the
ODBC/JDBC mapping tables. Instead the query will process“asis.”

Prompts that require a PC file as the data source are not supported.

STRATEGY 3.0 queries (.dbqg) and reports (.rpt) with prompting must be saved in Query or
Report Writer 4.0 or later for the prompting to work with Dynamic Web Reporting.

Analyzer Release Notes

m  Form linking is supported for both view linking and data cell linking, but links can only be
created in views, not in forms. To add alink to aview and saveit, you must edit the actual view
using Analyzer.

In aform containing more than one view, all views will show custom filtering, if applicable.

If you drill down on amember that was not selected in any of the views in the form you are
linking to, Analyzer will put that member in the filters.

m If you drill down on a member whose dimension does not exist in the data model view that is
in the form that you are linking to, the form will load with no changes at all.

m If you drill down on a member that does not exist (but the dimension does) in the data model
view that isin theform that you arelinking to, Analyzer will put that member in the column/row
and show all zerosfor data.

m |f you drill down on a member that doesn’t exist in alinked component (for example, a drop-
down list) that isin the form that you are linking to, the member will not appear as the current
selection in the component.
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Analyzer for the Web Release Notes

Analyzer for the Web requires Internet Explorer 5.5 or later.
Data models with prompts or variables are not supported.

When you try to link forms, the form will open but the members you filtered will not be sent
to the next view. Y ou will receive a message stating this.

Migrating from STRATEGY Analyzer to Hyperion Analyzer

Beginning with STRATEGY 4.0, two versions of Analyzer are available: STRATEGY Anayzer
and Hyperion Analyzer. STRATEGY Analyzer continues to use the i Series (AS/400) asa
repository while Hyperion Analyzer uses Oracle, SQL Server, Paradox, and DB2 on NT. Likewise,
STRATEGY Analyzer for the Web will continue to use the i Series while the Hyperion Web Client
will require an NT server.

If you are migrating to Hyperion Analyzer or Hyperion Web Client or are considering migrating,

this section contains general considerations, migration issues, and installation issuesfor end users.
For administrative Hyperion Analyzer migration information such as installing Hyperion
Analyzer, migrating groups and views, and database maintenance, seethe STRATEGY 4.5 Upgrade
Guide at http://support.spss.com/upgradeinfo/.

Considerations

The Disable print/export, Report Cancel Retrieval, and Cache Member List features of
STRATEGY Analyzer are not available in Hyperion Analyzer.

Support for datamodelsin STRATEGY Analyzer for the Web is not available in Hyperion
Web Client or Hyperion Analyzer. Accessto relationa datais supported through virtua cubes
in Hyperion Web Client and Hyperion Analyzer.

For more information about Hyperion Analyzer features, see the Hyperion documentation.

Installation Issues

The Hyperion Analyzer CD does not install Essbase Runtime Client, Virtual Cube support
(ODBC), or the Group Export utility. For more information, see “Hyperion Analyzer
Considerations’ on p. 50 in Chapter 6.

Migration Issues

The following list includes tasks that you may need to perform as a part of the migration process:

When migrating your Analyzer groups from STRATEGY Analyzer to Hyperion Analyzer,
export your groups from STRATEGY Anayzer and import them into Hyperion Analyzer. For
more information about migrating groups and about the STRATEGY Group Export tool, see
the STRATEGY 4.5 Upgrade Guide at http://support.spss.com/upgradeinfo/.

A STRATEGY Anayzer form that isimported and loaded into Hyperion Analyzer may not
display theindividual tabs for a Tab Set box if the panel containing the Tab Set box is too
narrow. If the panel hasasplitter, you can increase the width of the panel and seetheindividual
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tabs. If the panel does not have asplitter, you must open the form in Analyzer Designer and add
asplitter to that panel.

m  Because the Chart Tool has been updated in Hyperion Analyzer, you will see differencesin
chart views in terms of layout, background, colors, etc.

All lists created in STRATEGY Analyzer must be recreated in Hyperion Analyzer.

If you are migrating from STRATEGY 3.0 and your calculations were created in aprior release
without being resaved in STRATEGY 3.0, the calculations will not migrate.

m |f aview was created prior to STRATEGY 2.5 and migrated to 2.5 or later and was never
resaved, calculations, traffic lighting, and formatting will not migrate.

Migrating STRATEGY Analyzer Groups

To migrate your STRATEGY Analyzer groups to Hyperion Analyzer, you use the STRATEGY
Group Export utility and the Hyperion Import/Export utility. For more information, see the
STRATEGY 4.5 Upgrade Guide at http://support.spss.com/upgradeinfo/.

Hyperion Analyzer and Hyperion Web Client Release Notes

For release notes and migration information, see the Hyperion documentation accompanying your
Hyperion Analyzer CD.

Report Writer Release Notes

You can no longer insert pictures of file types .gif and .wmf into Report Writer.

Warehouse Builder Release Notes

When Warehouse Builder runs a definition, it pulls data in blocks of records, inserts the datainto
the target table, and converts the data mapping errors in the rows of the blocks to null values.
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Environment Requirements

This chapter describes the environment requirements for STRATEGY installation and setup.

Warning: If you fail to meet the software requirementsin this chapter, STRATEGY may not
function properly. Read this information carefully.

iSeries (AS/400) Requirements

0S/400 Requirements

STRATEGY iSeries software requires OS/400 Version 4, Release 5 (V4R5) or |ater.

Disk Space

Make sure that you have enough free disk space to install the servers.

Table 3-1
Disk space required for server installation

Component Space Required

Warehouse Manager Server | 280MB
Essbase/400 Server 150MB

280MB (After installation, this spaceis freed
when the installer signs off.)

Temporary Space

Server Preparation

If you are anew or current Enterprise Reporting user, or if you will save, share, and manage query
and report definitions via ShowCase Server, you must install Orion Application Server. When you
install Orion, you will be prompted to enter the Orion Install key. If you do not have a key, contact
ShowCase Support before you begin server installation.

17
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Back Up Existing Libraries

You must install Warehouse Manager and Essbase/400 servers in separate installation libraries. If
you plan to install in an existing Warehouse Manager Server library, first stop the server in that
library and verify that no users are connected. For instructions on stopping the servers, see the
STRATEGY Administrator’s Guide.

Always back up your Warehouse Manager and Essbase/400 libraries before installation. Although
the serverswill install over existing 3.0, 3.5, 4.0, or 4.1 server libraries, we recommend backing up
your librariesto guard against installation failure. See the STRATEGY Administrator’s Guide.

Configure and Start TCP/IP

You must configure and start iSeries TCP/IP before installing the servers. Someone trained in
TCP/1P network administration should ensure proper setup, use, and maintenance of TCP/IP.

For more information on configuring TCP/IP, see the STRATEGY Administrator’s Guide. Also
seeyour IBM documentation.

J.D. Edwards Requirements

STRATEGY 4.5 supportsversions A7.x and A8.x of J.D. Edwards WorldSoftware and version
B7.33.x of J.D. Edwards OneWorld Software.

STRATEGY provides user profile, data dictionary, and cost center security support for these
WorldSoftware versions. Due to internal changes to the WorldSoftware database structure, user-
developed queries or other STRATEGY applications may not be interchangeable across
Worl dSoftware rel ease boundaries. See your J.D. Edwards documentation for changes to
WorldSoftware database structures.

Administrators can how use the SETIDEOWA command to enable STRATEGY to recognize
environment information for OneWorld users who do not have an iSeries user profile. For
instructions, see the STRATEGY Administrator’s Guide.

Warehouse Manager Server Requirements

The server installation requires and verifies the following requirements:
m  0S/400 V4RS or later

m JavaDeveloper Kit (option during OS/400 installation)
V4R5: 5769V 1 Java Developer Kit 1.3
V5R1: 57223V 1 Java Developer Kit 1.3

m Toolbox for Javainstalled
V4R5: 5769JC1 Toolbox for Java
V5R1: 5722JC1 Toolbox for Java
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m  QShel Interpreter
V4R5: 5769SS1 OS/400 QShell Interpreter
V5R1: 5722SS1 OS/400 QShell Interpreter

S36 files are no longer supported. You must use DB2/400 externally described files.

Warehouse Manager Server Installation Tips

m |nstall Warehouse Manager Server in an existing Warehouse M anager Server library of version
3.00r later or inanew library. Do not install it in an existing user library or an Essbase/400
library.

m Configure and start i Series (AS/400) TCP/IP before you enable STRATEGY TCP/IP. You do
not have to enable STRATEGY TCP/IP support at installation time. Y ou can enable it later
using the CHGSCSVRA command.

m  Remember the IP address of your iSeries (AS/400) and the port number assighed to each
library. Y ou and your users will need thisinformation to complete ODBC setup.

m If you areinstalling Enterprise Reporting, remember your Orion Application Server port
number for use in the browser.

During Warehouse Manager Server installation, you will be prompted to add the Warehouse
Manager library to QALWUSRDMN. The default setting for the QALWUSRDMN system value is
*ALL. If that setting isn’t acceptable for your environment, before you install Warehouse Manager
Server, specify the following libraries for QALWUSRDMN: QSYS, QRPLOBJ, QTEMP, and the
Warehouse Manager Server library (default SCSERVER).

Theselibraries help Warehouse Manager Server install correctly and help prevent unpredictable
results when you run client applications. To work with system values, use the i Series (AS/400)
command WRKSYSVAL and choose option 2 to change QALWUSRDMN.

Additional Considerations

m  Warehouse Manager Server sets*PUBLIC Exclude as the default authority to Warehouse
Manager Client and Warehouse Builder. A profile with *ALLOBJ authority can use Warehouse
Manager Client to authorize other users to access Warehouse Manager Client or Warehouse
Builder.

m  Theuser profile QUSER should have the Maximum Allowed Storage (MAXSTG) parameter set
to the default *NOMAX. Otherwise, you may have difficulty connecting through TCP/IP and
running large queriesin batch.

m  ShowCase security applied to a supplementa group (via Warehouse Manager Client) is not
supported. However, AS/400 security applied to a supplemental group (via a non-ShowCase
interface) is supported. i Series authorities applied to a user profile as a result of supplemental
groupswill be honored when the user isrunning applications connected to Warehouse M anager
Server. Thus, STRATEGY supportsiSeries security against supplemental groups, but it does
not recognize STRATEGY security applied to a supplemental group.
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Essbase/400 Server Requirements

0S/400 V4R5 or later
TCP/IP configured and started on the i Series (A S/400)

Java Developer Kit
V4R5: 5769V 1 Java Devel oper Kit 1.3
V5R1: 57223V 1 Java Developer Kit 1.3

If you have more than one Essbase/400 Server installed on a single i Series, each server must have
its own I P address. For more information, see “ Essbase/400 Server” on p. 41 in Chapter 5.

Essbase/400 Installation Tips

Install Essbase/400 in an existing Essbase/400 library of version 3.0 or later or in anew library.
Do not install it in an Essbase/400 library of version 2.5 or earlier, an existing user library, or a
Warehouse Manager Server library.

If you are reinstalling an existing Essbase/400 library that isin use, stop the server before
installation. See the STRATEGY Administrator’s Guide.

During Essbase/400 installation, you will be prompted to add the Essbase/400 library to
QALWUSRDMN. The default setting for the QALWUSRDMN system valueis*ALL. If that setting
is not acceptable for your environment, before you install Essbase/400, specify the following
librariesfor QALWUSRDMN: QSYS, QRPLOBJ, QTEMP, the Warehouse Manager Server library
(default SCSERVER), and the Esshase/400 Server library (default ESSBASE). These libraries
help Esshase/400 install correctly and help prevent unpredictable results when you run client
applications (including Analyzer). To work with system values, use the i Series (A S/400)
command WRKSYSVAL and choose option 2 to change QALWUSRDMN.

On double-byte systems, if you are using * HEX CCSID value 65535, the language identifier
for the job may cause a default CCSID value of 5026 that does not support lowercase English
characters. If you must run the job under the * HEX CCSID, change the language ID of the job
s0 0S/400 does not cal culate 5026 as the default CCSID. For example, configure thejob to use
ENP asthelanguage ID. OS/400 will calculate adefault CCSID value of 37, which is supported
by Essbase/400. For more information, see “ Installing and Running on a Double-Byte System”
on p. 44 in Chapter 5.

Essbase/400 data load and dimension build operations are most efficient with SQL interface
support. The SQL interface support is shipped as part of the base Essbase/400 package; you do
not need to install a separate SQL interface module.

To set up your iSeries to allow SOL loads:

» At aniSeries command line, type WRKRDBDIRE and press Enter. If you do not see an entry for
*LOCAL, use option 1 to add a*LOCAL entry.
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Client PC Software and Hardware Requirements

Table 3-2 lists requirements for the STRATEGY PC software applications.

Table 3-2
PC requirements

Computer IBM or |BM-compatible personal computer

One of the following Microsoft Windows operating systems:
Operating Windows 98, Windows 2000, Windows NT 4.0 (Service Pack 5 or later), or Windows XP
System

Note: The Enterprise Server and the Hyperion Analyzer for the Web server require
Windows NT 4.0 (Service Pack 5 or later), Windows 2000, or Windows XP.

Web Browser Internet Explorer 5.5 or later, or Netscape Navigator 6.2 or later.

Microprocessor | Pentium 133 or the minimum required by your operating system.

RAM 64MB of RAM or the minimum required by your operating system.

300MB or greater available hard disk space for the following applications
(space needed will vary depending on components sel ected):

Warehouse Manager Client

Analyzer

Warehouse Builder

Report Writer (including Query)

Hard Disk Space | Query Excel Add-in

Query Lotus Add-in

Esshase Application Manager

Essbase Spreadsheet Add-in for Lotus Millennium or later

Essbase Spreadsheet Add-in for Excel 97 and Excel 2000

Enterprise Server (requires Windows NT, Windows 2000, or Windows XP)

Samplefiles
Disol VGA monitor (640 x 480 resolution minimum; 800 x 600 or more
splay
recommended).
Warehouse Manager Server requires a TCP/IP connection to the i Series.
Networ k For Analyzer and Essbase client applications (Application Manager, spreadsheet
Protocol add-ins), configure a Windows Socket compliant TCP/IP connection between your

client PC and your Essbase/400 Server. See the STRATEGY Administrator’s Guide.

Other CD-ROM drive (or network accessto a CD-ROM drive).
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Analyzer for the Web Requirements

HTTP Server Requirements

To use Analyzer for the Web, you must install and configure an HTTP server. If you aso use
Enterprise Reporting, use Orion Application Server asan HTTP server. It isavailable during server
installation. If you do not use Enterprise Reporting, you can usethe IBM HTTP server.

m Toinstal Orion, see“Orion Application Server” on p. 37 in Chapter 5.

m Toset up Orion asthe HTTP server, see“ Configuring the Orion Application Server for
Analyzer for the Web” in Chapter 5 of the STRATEGY Administrator’s Guide.

m TosetupthelBM HTTP server, see Configuring theiSeriesHTTP Server” in Chapter 5 of the
STRATEGY Administrator’s Guide.

If you want external usersto access Analyzer for the Web through afirewall, additional
configuration is required.

m To configure firewall support for Orion or Websphere, see “ Analyzer for the Web Support for
Firewalls and Proxy Servers’ in Chapter 5 of the STRATEGY Administrator’s Guide.

Web Browser Requirements

Analyzer for the Web requires Internet Explorer 5.5 or later.

For information and requirements on Hyperion’s Analyzer version for NT, see the Hyperion
documentation.

Double-Byte System Requirements

If you are using a double-byte character set (DBCS) to represent character data (for example,
Japanese or Chinese), use these steps to set up your systems.

» Install Client Accessversion VAR5 or later from your iSeries. The path is:
/qibm/ProdData/CA400/Expresy/I nstall/lmage

» Install STRATEGY asdescribed in Chapter 5 and Chapter 6.

» Tocompleteyour DBCS setup, follow the stepsin “ Setting Up Y our PC for Double-Byte Character
Data” on p. 45.

Server Requirements for Enterprise Reporting

Enterprise Reporting enables users to access (via a Web browser) shared queries and reports saved
to Warehouse Manager Server. It requires the following server components:
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m |IBM Host Servers
V4R5 requires 5769SS1 OS/400 Host Servers
V5R1 requires 5722SS1 OS/400 Host Servers

m JavaGroup PTFs
V4R5 requires SF99068
V5R1 requires SF99069

m Database Group PTFs
V4R5 requires SF99105
V5R1 requires SF99501

Warehouse Manager Server

Orion Application Server. Y ou can choose to install this server during server installation. For
instructions, see Chapter 5.

For a complete list of the Enterprise Reporting requirements, see the Enterprise Reporting
Administrator’s Guide at http://support.spss.com. After installation, you can find the guide on the
Documentation page:

» From the Windows Start menu, choose:

Programs
ShowCase STRATEGY 4.5
Documentation

Non-DB2 Data Source Requirements

If you are using datasources such as SQL Server, Oracle, or Domino, you can find the requirements
and setup instructions at http://support.spss.com. After you log on, click Documentation, and then
STRATEGY Manuals.

Warehouse Builder Requirements

If you are using iSeries data sources, the following are the installation requirements and
recommendations for Warehouse Builder.

®  You must have an iSeriesfor acontrol server. The control server must be the same
STRATEGY version as the client version you areinstalling (4.5).

m By default, only users with *ALLOBJ authority can use Warehouse Builder. To authorize users,
grant them application authority in Warehouse Manager Client.

m Distribution performanceis better if the target tableis not journaled. To avoid using journaled
tables: verify that the target collection is created using the CRTLIB command rather than the
SQL command CREATE COLLECTION. Also, open Warehouse Builder, and from the Tools
menu, choose Options. On the Defaults tab, make sure Create Target SQL Collection is not
selected. Deselected is the default setting.

m Thejob queue SCDDJOBQ is added to the subsystem that you choose during installation. The
maximum number of jobs on the Job Queue entry of the subsystem is set to *NOMAX by default.
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A routing entry is added to the subsystem that you choose during installation (if the routing
entry doesn't exist). It usesthe class QGPL/QWCPLSUP. If you want to use adifferent class, you
can change it after the installation is complete. For details, see Chapter 5 of the STRATEGY
Administrator’s Guide.

If either of the Warehouse Manager Server options Exclude users from libraries by default or
Exclude users from tables by default is selected, you must have *ALLOBJ or data administrator
authority to access all information when using Warehouse Builder to create tables.

0S/400 VAR5 users only: To work with Warehouse Builder definitions that contain JDE data
and UDC columns, you must apply the following PTF or the definitions will not run: 5769SS1
VAR5MO SF64377.

Warehouse Builder Remote iSeries Setup

To use Warehouse Builder with remote i Series, distributed relational database architecture
(DRDA) communication isrequired between each remotei Series and the control server iSeries.
If your iSeries are not connected and you need help configuring DRDA, consult your IBM
documentation.

Y ou must enable the DRDA-compliant communi cations between your control server and
remote iSeries. You can use SNA or TCP/IP communications for your DRDA connections.

TheiSeries acting as the control server must have arelational database directory entry for each
remote iSeries. To add the entry, use the ADDRDBDIRE command on your control server.

Windows NT, Windows 2000, and Windows XP Requirements

For all types of client installations, you must have administrator authority to your PC registry to
install STRATEGY. For more information, see your Windows documentation.
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Naming PCs

Each PC has one name for connecting to all Warehouse Manager Server libraries across all i Series
(AS/400s). Therefore, the PC name must distinguish your PC from others running STRATEGY.
Under per-seat licensing, the PC name registers your computer as alicensed PC to a Warehouse
Manager Server library.

All clients must enter a PC name when installing STRATEGY. The default name that appears
during installation is based on the PC’'s Windows network name (if one exists). The name entered
during installation appears during subsequent product installations.

The PC name is case sensitive and can contain up to 50 characters, including:

A-Z > ‘ -
az % ( .
+ & ) /
< * :

Naming Tips

You may want to establish company-wide PC naming guidelines that make sense to you and your
users to simplify license maintenance. For example, if PCs stay with users when the users move,
you may use haming conventions based on user names. But if PCs stay with adepartment, you may
use haming conventions based on a department name or code. Choose the naming convention that
suits your situation, and be consistent with those guidelines.

Changing the PC Name

Windows NT

» From the desktop, right-click on Network Neighborhood.

» On the Network Identification tab, your PC name appears.

» To changethe name, click the Change button.

25
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Windows 2000
» From the desktop, right-click on My Computer.
» On the ldentification tab, your PC name appears.

» To change the name, click the Properties button.

Using the AS/400 Test Connection
After installation, you can see or change your PC name using the AS/400 Test Connection.

» From the Windows Start menu, choose:

Programs
ShowCase STRATEGY 4.5
AS/400 Test Connection

» Click Global Settings.

» On theLicensing tab, enter aname for your PC.

If you have previously connected to Warehouse Manager Server under your old PC name, the new
PC name uses a new license when it successfully connects to Warehouse Manager Server, and the
old PC name retains alicense. In other words, using a different PC name uses another PC license.
If this occurs, you can remove the old PC license through Warehouse Manager Client. To remove a
PC license, see “ Transferring or Removing a PC License” on p. 30.

Warehouse Manager Server Licensing

Depending on your agreement, licensing for Warehouse Manager Server will be per-seat or
concurrent.

Concurrent Licensing

Warehouse Manager Server requires one password from each STRATEGY client product before
enabling connections for the software. Concurrent license passwords allow a defined number of
simultaneous connections to the i Series but an unlimited number of PC installations. Warehouse
Manager Server monitors the number of users connected simultaneously, and when you reach the
maximum number of licensed connections, the server prohibits connections until one or more users
disconnect. Connection is granted on afirst-come, first-served basis.
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Per-Seat Licensing

Under per-seat licensing, you purchase aparticular number of PC licensesfor specific STRATEGY
products to enable users to connect to Warehouse Manager Server data sources on one or more of
your iSeries (for example, x licenses for Query, x licenses for Report Writer). Thefirst time auser
connects to the Warehouse Manager Server data source, the PC name is checked, and, if the name
isvalid and unique and there are available licenses to that product, the user is granted alicense to
the product and is allowed to continue.

OnceaPC initializesalicensg, it reserves one license regardless of its connection status or the
number of Warehouse Manager Server libraries on asingleiSeriesto which it can connect. When
the maximum number of licensesis used (the total number of PC licenses per product purchased),
no additional connections to the data source are allowed. A user attempting to connect after the
maximum number of licenses are in use will receive an error message.

Then you must either remove unused licenses or purchase additional licenses. When you
purchase additional licenses, a new password allows you to increase your maximum number of
licenses. If aPC licenseis removed, that PC cannot connect to Warehouse Manager Server until
the PC softwareis reinstalled. To remove a PC license, see “ Transferring or Removing a PC
License” on p. 30.

Using Warehouse Manager Server Passwords

Passwords control STRATEGY licensing. The servers (Warehouse Manager and Essbase/400)
each maintain the application passwords licensed to them.

When you install Warehouse Manager Server, you will have demo accessto all STRATEGY PC
software that connects to the server, including Warehouse Manager Client, Warehouse Builder,
Query, Report Writer, Analyzer, Analyzer for the Web, and Enterprise Reporting. Demo access
allows you to try the software for 60 days.

For the Warehouse Manager Server to access Esshase/400, a STRATEGY Essbase/400 license
must be avail abl e or the connection will berejected. For more information, see“ Using Essbase/400
Server Passwords’ on p. 29.

To use Warehouse Manager Server products beyond the 60-day demo period, use temporary or
permanent passwords.

Temporary Passwords

Temporary passwords expire on a specific date. Occasionally, temporary passwords are issued if
the demo period has expired and you have not received a permanent password, or if you are
conducting atraining class and need temporary additional accessto STRATEGY. Contact your
sales representative or ShowCase support for temporary passwords.
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Permanent Passwords

Entering

Permanent passwords never expire. However, you must have a new password if you upgradeto a
different iSeries model or serial number.

Warehouse Manager Server requires separate passwords for the following products:
Warehouse Manager Client (includes Query)

Warehouse Builder

Report Writer

Enterprise Reporting

Analyzer

Analyzer for the Web

Passwords

You can enter Warehouse Manager Server passwords in the following ways.

To Enter Passwords from the iSeries

>

Log on with QSECOFR or equivalent authority (*ALLOBJ, *IOSYSCFG, *SAVSYS, *JOBCTL, and
*SECADM authorities are needed).

To add the Warehouse Manager Server library to your library list, type the command ADDLIBLE
SCSERVER, where SCSERVER is the name of your Warehouse Manager Server library.

Type the command CHGSCAUT, and press Enter.
Enter the valuesfor each password (password, number of users, expiration date). The product name
isnot specified becauseit is stored with the password. Thus, when you enter the password, you are

specifying the product name.

Repeat the previous step for each password you received.

To Enter Passwords from Warehouse Manager Client

>

>

v

Open Warehouse Manager Client.
Click the data source to which you want to connect.
On the File menu, click Connect.

Connect to your iSeries (AS/400) with QSECOFR or equivalent authority (*ALLOBJ, *IOSYSCFG,
*SAVSYS, *JOBCTL, and *SECADM special authorities are needed).
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» Double-click the data source to list the data types (libraries, profiles, and applications.)
» Double-click Applications to display alist of licensed products for Warehouse Manager Server.

» Click the product (for example, Warehouse Builder, Query, Analyzer, Analyzer for the Web) to
which you want to add a license.

» From the Manage menu, choose:

Passwords
Add Password

» Enter the values for the password (password, number of users, expiration date).

» Click Update.
Repeat these steps for each password that you received.
For more information about licensing, see “Managing Per-Seat Licenses” on p. 30.

Using Essbase/400 Server Passwords

The Essbase/400 password isthe i Series (A S/400) product serial number, and it isvalid only for a
single installation of the Essbase/400 Server. The serial number allows a defined number of first-
come, first-served connections to the Essbase/400 Server from Essbase/400-compliant software
(for example, Analyzer, Warehouse Builder, Microsoft Excel, Lotus 1-2-3, Essbase/400
Application Manager).

When you install the latest version of Essbase/400 into an existing STRATEGY Essbase/400
library, you must enter the product serial number (or specify *DEFER).

If you specify *DEFER, you can enter the product serial number after installation by running the
i Series Essbase/400 CHGESSENV command. You must enter this number before Essbase/400 will
allow connections to the server.

There are two types of product serial numbers, temporary and permanent, which are discussed
in the following two sections.

Temporary Product Serial Numbers

Temporary product serial numbers expire on a specific date.

Permanent Product Serial Numbers

Permanent product serial numbers never expire. However, you must have a new product serial
number if you upgrade to a different i Series model or seria number.
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To enter the product serial number (if you did not enter it during installation):

» Log off theiSeries and log on with QSECOFR or equivalent authority (*ALLOBJ, *IOSYSCFG,
*SAVSYS, *JOBCTL, and *SECADM authorities are needed).

» Toaddthe Essbase/400 library to your library list, type the command ADDLIBLE ESSBASE, where
ESSBASE isthe name of your Essbase/400 library.

» Typethe command CHGESSENYV, and press F4.

» Enter the value for the serial number. Leave the value asit is (*SAME) for the other options.

Managing Per-Seat Licenses

This section applies to per-seat licensing of Warehouse Manager Server and the PC products
Warehouse Manager Client, Query, and Report Writer.

Transferring or Removing a PC License

Transferring or removing a PC license applies to STRATEGY per-seat licenses. You need to
transfer or remove alicense only when the PC no longer needsthe license. Use Warehouse M anager
Client to view the available licenses and remove them.

To transfer or remove a license:
Open Warehouse Manager Client, and connect to a data source.
Double-click Applications to list the available applications for the data source.

Click the desired application.

vV v v Vv

From the Manage menu, choose Per-Seat Licenses to display PCs licensed to the application.

For each PC, the user who most recently connected to the application using that PC and the
date/time of the connection is displayed.

Note: If the command is not available to you, highlight it, and press F1 for an explanation.
» Click the PCsthat you no longer want licensed to the selected application.

» From the License menu, choose Remove. Y ou will be asked to confirm that you want to delete the
selected PC names and their licenses.

Important: When you remove alicense, the PC can no longer connect to Warehouse Manager
Server until the PC softwareis reinstalled.

Reinstalling STRATEGY PC Software

If aPC licenseisremoved using Warehouse Manager Client, you must reinstall the PC software to
get anew license. The original PC name will appear asthe default name if STRATEGY is
reinstalled, but you can changeit.
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This chapter coversthe STRATEGY server installation including Warehouse Manager Server and
Essbase/400 Server.

Before You Install

Refer to the STRATEGY 4.5 Upgrade Guide at http://support.spss.com/upgradeinfo/.

Always save server information with the SAVSRVRINF command before you install over
STRATEGY 3.0 or later. For more information, see Chapter 5 of the STRATEGY
Administrator’s Guide.

Read Chapter 3 for all prerequisites. If you are installing on a system with double-byte
character set (DBCS) support, see “Installing and Running on aDouble-Byte System” on p. 44.

When you install STRATEGY, the installation selects a TCP/IP port number for you. If you
want to select your own port number, use the WRKSRVTBLE command before installation to
find an available number.

Important: If you are using Enterprise Reporting, you must migrate your 3.0, 3.5, 4.0, or
4.1 Information Directory objects and documents to the new Web deployment framework.
Y ou will have the option to migrate during installation, or you can choose to migrate later.
For information, see the Enterprise Reporting Administrator’s Guide at
http://support.spss.com. After installation, you can find the guide on the Documentation
page by following the steps below:

» From the Windows Start menu, choose:

Programs
ShowCase STRATEGY 4.5

Documentation

31
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Beginn

>

ing Server Installation

Save your current server information with the SAVSRVRINF command. For more information, see
the STRATEGY Administrator’s Guide.

Load the STRATEGY iSeries (AS/400) CD into the iSeries CD drive.

Log on with QSECOFR or equivalent authority (*ALLOBJ, *IOSYSCFG, *SAVSYS, *JOBCTL, and
*SECADM special authorities are needed). The profilethat you use must be a permanent profile
that does not belong to any groups or supplemental groups. If it isremoved from the system,
you may haveto reinstall the server.

Type LODRUN and press F4.

Y ou will be prompted for a device name. Choose *OPT or the name of your optical device.

Y ou will be prompted for a path name. Accept the default path.

Follow the screen instructions and use this chapter to complete the installation.

Initial Installation Options

The optionsthat you choose from theinitial installation screens determine the screens, options, and
order of your installation. Each heading in the following sections matches a screen in the server
installation.

Theinstallation displays recommended valuesfor the options. If you are upgrading STRATEGY
server software, existing values are retrieved.

STRATEGY Servers

Choose the STRATEGY server(s) to install:

Warehouse Manager Server. This server supports Query, Report Writer, Warehouse Builder,
Warehouse Manager Client, Analyzer, Analyzer for the Web, and Enterprise Reporting.

Esshase/400 Server. This server supports Analyzer, Analyzer for the Web, Essbase/400 Application
Manager, Microsoft Excel and Lotus 1-2-3 Esshase/400 add-ins, and other Essbase/400-compliant
PC software.

Note: You cannot install Warehouse Manager Server and Essbase/400 Server into the same server
library.

Table 5-1 lists the STRATEGY software and the server with which it communicates.
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Table 5-1
STRATEGY PC Software
PC Software Purpose Server*
Anayzer Data analysis ESS, WM
Data analysis via an intranet or
Anayzer for the Web extranet ESS, WM
Relational and multidimensional
Query database query tool WM, ESS
Report Writer Relational and multidimensional WM. ESS

database report writer
Enterprise Server Enterprise reporting WM
Data cleansing, transformation,

Warehouse Builder and distribution WM, ESS
Warehouse Manager Client Database administration WM
Essbase/400 Application Manager gﬂdﬂmgt?ggzgna] database ESS
Essbase/400 Excel add-ins Dataanalysis ESS
Essbase/400 .

Lotus 1-2-3 Millennium add-ins | DA2anaysis ESS

*WM refers to Warehouse Manager Server. ESS refers to Essbase/400 Server.

National Language Support

Specify the primary and secondary languages for the STRATEGY products. Choose ENU for
English lowercase or ENP for English uppercase. STRATEGY commands use the primary
language.

If you areinstalling Warehouse Manager Server, continue with the next section. Otherwise, skip
to “ Essbase/400 Installation Options” on p. 41.

Warehouse Manager Server Installation Options

This section describes the Warehouse Manager Server installation. Each heading matches a screen
in the installation. For the Essbase/400 Server installation, see “ Essbase/400 I nstallation Options’
onp. 41

Warehouse Manager Server Library

Specify the library in which to install Warehouse Manager Server. The screen displays current
Warehouse Manager Server libraries. Choose alibrary to upgrade, or press F6 to install anew
library.

The default library name is SCSERVER. In addition, the root Integrated File System (IFS) path
used for the installation is based on the specified library name (the default is/SCSERVER).
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Aucxiliary Storage Pool (ASP) ID. If you add alibrary, you are prompted to enter the ASP ID. Accept
the default or enter the number of the ASP from which the system should alocate storage for the
Warehouse Manager Server library. (IFS information installed with Warehouse Manager Server is
aways placed in the system ASP)

To Change the Library After Installation

To change the library, you must reinstall it. Before you install anew library, save the catalog files
from the old library using the SAVSRVRINF command and restore into the new library using the
RSTSRVRINF command. For more information, see the STRATEGY Administrator’s Guide.

STRATEGY Interlink for J.D. Edwards

Choose this option to enable STRATEGY Interlink for J.D. Edwards. For details, see the
STRATEGY Administrator’s Guide.

To Enable STRATEGY Interlink for J.D. Edwards After Installation

If you installed without STRATEGY Interlink for J.D. Edwards, you must install the product
passwords for STRATEGY Interlink for J.D. Edwards support. Enter the passwords in Warehouse
Manager Client or with the i Series (AS/400) command CHGSCAUT. For instructions, see* Entering
Passwords’ on p. 28 in Chapter 4.

Warehouse Manager TCP/IP Port Configuration

TCP/IPcommunicationsruns STRATEGY and Essbase/400 client applications, and theinstallation
requiresavalid TCP/IP port number. Previously, the Warehouse Manager Server and the Analyzer
OLAP Server (AOS) used two separate ports. With the release of STRATEGY 4.0, the AOS was
incorporated into the Warehouse Manager Server, but you have the option to keep both ports. If you
currently have two ports, see “ Should | Use One or Two Ports?’ below.

If you areinstalling over STRATEGY 4.x and you currently have only one port, accept the
default port number (43419 or the next available number) or enter a port number in the range of
6000-65535, using the i Series command WRKSRVTBLE to find available port numbers.

Note: Record your TCP/IP port number. You will need it when installing the client software.

Should I Use One or Two Ports?

In STRATEGY versions prior to 4.0, the AOS and Warehouse Manager Server (SCSERVER) used
two separate ports. However, with versions 4.0 and later, the AOS port is incorporated into the
Warehouse Manager Server port. If you are upgrading to version 4.5 and use Analyzer, you can
retain both ports. However, future STRATEGY releases will support only one port.

If you choose to use only the Warehouse Manager Server port and wish to save datato the
ShowCase Server, you must later configure your AOS connections on each PC to use the Warehouse
Manager Server port number. Use port numbers greater than 6000.
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To change the AOS port number:
» Open Query.
» From the Tools menu, choose ShowCase Servers.
» Choose your server, and click the Edit the Server Propertiestool.
» IntheEdit ShowCase Server dialog box, change the port number to match the Warehouse M anager

Server port number that you chose at installation.
In Analyzer, change the port number in the OLAP Connection dialog box.

To Change the TCP/IP Port Number After Installation

Note: The CHGSCSVRA command will stop the server, disconnect all current users, and stop
current jobs. It will also start the server after changes have been made.

» Add the server library nameto your library list.
» Type WRKSRVTBLE to determineif the port that you want to use is available.

» Type CHGSCSVRA, and add the new port number, subsystem, and library.

Note: If you retain both ports from aSTRATEGY 3.x or 4.x release, you can configure the second
port with the CHGSCSVRA parameter SecondaryTCPIPPort. For moreinformation on CHGSCSVRA
settings for Analyzer functionality, see Appendix A in the STRATEGY Administrator’s Guide.

Work Management and CCSID Configuration

Specify the following options for Warehouse Manager Server. If you will not use Analyzer-related
applications, accept the defaults for the Analyzer OLAP options.

Relational Subsystem and Library. Warehouse Manager TCP/IP jobs will run in the relational
subsystem. Your current subsystem, as determined by the QCTLSBSD system value, is displayed
and should not be changed.

Note: If the controlling subsystem is QBASE, then QBASE is the default. If the controlling
subsystem is QCTL, then QCMN is the default. To find the controlling subsystem, type
DSPSYSVAL SYSVAL(QCTLSBSD).

The subsystem description resides in the specified library. QSYS isthe default.

AO Server CCSID (EBCDIC). Warehouse Manager Server uses the Analyzer OLAP Server (AO)
Extended Binary Coded Decimal Interchange Code (EBCDIC) coded-character set identifier
(CCSID) to represent character data when interacting with Essbase/400, DB2/400, and OS/400.
The recommended EBCDIC CCSID value for your system is displayed.
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The EBCDIC CCSID must bethe samefor each Essbase/400 server that Analyzer and Analyzer for
the Web users access. Also, you can specify only one EBCDIC CCSID for each Warehouse
Manager installation library. For CCSID pairs, see Table 5-2.

A0 Client CCSID (ASCII). Warehouse Manager Server usesthe AO Client ASCII CCSID for PC-based
operations. It is used during startup time, before the client CCSID is determined, and it supports
tranglation to and from the EBCDIC CCSID. This does not affect what code page or encoding
Windows and Web clients are able to run. Warehouse Manager Server supports multiple Windows
and Web clients on any code page or encoding that supports translation to the EBCDIC CCSID.

Theinstallation calculates this value based on the EBCDIC CCSID value. For example, if the
EBCDIC CCSID is 37, the matching ASCII CCSID is 1252, which supports Western European
languages (English, French, German, Italian). To find valid CCSID pairs, see Table 5-2.

To Change CCSIDs After Installation

To changethe server CCSID, reinstall Warehouse Manager Server. To changetheclient CCSID, see
the STRATEGY Administrator’s Guide.

CCSID Pairs

Thefollowing EBCDIC and ASCII CCSID pairs are recommended for Warehouse M anager Server
and Esshase/400 Server. For details on Essbase/400 CCSIDs, see “ Essbase/400 Server” on p. 41.

Table 5-2
Recommended Warehouse Manager Server and Essbase/400 EBCDIC and ASCII CCSID Pairs

Country, Geogr aphic Region, or Language Group (E:I(BZCS:IDDIC X;‘éﬁ?'ggcg D
United States/Canada/Brazil 37,1140 1252
Multi-national #1 256 1252
Germany/Austria 273, 1141 1252
Denmark/Norway 277,1142 1252
Finland/Sweden 278, 1143 1252

Italy 280, 1144 1252
Spain/Latin America 284, 1145 1252
United Kingdom 285, 1146 1252
France 297, 1147 1252
Greece 423, 875 1253
Multi-national #5 500, 1148 1252
Korea (single-byte) 833 1040, 1088
Korea (double-byte) 933 944, 949
Chinese Simplified (single-byte) 836 1115
Chinese Simplified (double-byte) 935 1381
Chinese Traditional (double-byte) 937 938
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Country, Geographic Region, or Language Group (E:?:%PE;C Xsact:ﬁﬁ"g%g D
Chinese Traditional (single-byte) 37, 28709 904
Japan (double-byte) 939, 5035 932, 943
Japan (single-byte) 1027 932
Thailand 838, 9030 874
Central Europe (Bosnia, Croatia, Czech Republic, Hungary, etc.) 870 1250
Iceland 871, 1149 1252
Cyrillic Multinational 880, 1025 1251
Baltics 1112, 1122 | 1250
Hebrew 62235 1255
Arabic (Essbase only; not yet supported in Analyzer.) 62224 1256

Orion Application Server

If you areanew or current Enterprise Reporting user, or if you will save, share, and manage query
and report definitions viathe ShowCase Server, you must install the Orion Application Server. To
install the Orion server, enter Y. If you are not installing Enterprise Reporting, enter N. You can also
enter N and install the server later with the INSTORI command. If you entered Y to install Orion,
you will be prompted to enter the Orion Install Key. If you do not have akey, follow theinstructions
on the installation screen to obtain one.

If you are a current Enterprise Reporting user, you must also migrate your 3.0, 3.5, 4.0, or 4.1
Information Directory objects and documents to the new Web deployment framework. When you
install the Orion server, you have the option to migrate immediately after installation or defer until
later. For information, see the Enter prise Reporting Administrator’s Guide at
http://support.spss.com. After installation, you can find the guide on the Documentation page:

» From the Windows Start menu, choose:

Programs
ShowCase STRATEGY 4.5
Documentation

Enterprise Reporting Configuration

If you are installing the Orion server, enter the following information.

Orion Server Port. The Orion server requires aport number different from the Warehouse Manager
Server port number. Accept the default port number (48671 or the next available number) or enter
aport number in the range of 6000—-65535. To see what port numbers are already in use, run the
WRKSRVTBLE command from an iSeries command line.

Note: Remember this port number. You will use it to set up Enterprise Reporting.

JMS Server Port. This port is required by the Orion server. Accept the default (45577 or the next
available number) or enter a port number in the range of 6000-65535.

User Profile and Password. Enter an existing user profile with *ALLOBJ and *SECADM authorities
and a password to be stored and used for Enterprise Reporting security.

Subsystem and Library. Your current subsystem, as determined by the QCTLSBSD system value, is
displayed and should not be changed.
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Note: If the controlling subsystem is QBASE, then QBASE is the default. If the controlling
subsystem is QCTL, then QCMN is the default. To find the controlling subsystem, type
DSPSYSVAL SYSVAL(QCTLSBSD). The subsystem description resides in the specified library.
QSYS isthe default.

Note: To set up Enterprise Reporting, see the Enterprise Reporting Administrator’s Guide at
http://support.spss.com. After installation, you can find the guide on the Documentation page.

» From the Windows Start menu, choose:

Programs
ShowCase STRATEGY 4.5
Documentation

Enterprise Reporting Migration

If you areinstalling over a previous release in which you used Enterprise Reporting and you are
installing the Orion server, you must migrate your data.

If you enter *IMMED, the date parameter will be ignored and the migration will begin
immediately after installation. If you enter atime and date, the migration will begin at the time and
date you specify. You may enter *DEFER to postpone the migration and run it manually later. For
more information, see the Enterprise Reporting Administrator’s Guide at http: //support.spss.com.

Schedule JAR File Compile

To reduce server start-up time, the .jar filesinstalled in your Integrated File System (IFS) must be
compiled before you start the server. Because the compile may affect system performance, you can
compile immediately after installation or enter a date and time to compile.

If you enter *IMMED, the date parameter will be ignored and the .jar fileswill compile
immediately after installation. If you enter atime and date, the files will compile at the time and
date you specify.

Important: If you are migrating Enterprise Reporting objects, we recommend scheduling the .jar files
to compile after the migration. For best performance, choose *DEFER how and use the CMPSCJAR
command to compilethe .jar filesafter migration. Or schedule the compile during off-peak hours after
migration. Compile time may vary from three to four hours or more depending on system resources
and will be shorter if the Warehouse Manager Server is not running.

To Compile JAR Files After Installation

At aniSeriescommand line, run the CMPSCJAR command. You should a so run the command after
you apply PTFsto the Java Toolbox.
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Security Settings

Specify whether your Warehouse Manager users will have access to al libraries (*ALL) on the
iSeries or only libraries and filesin their library list (*LIBL). This setting applies only to
STRATEGY applications using Warehouse Manager Server.

To Change Security Settings After Installation
» Open Warehouse Manager Client.

» From the menus, choose:

Manage
Server Options
Security
You can also use the i Series commands SETLIBACC and CHGSRVRDFT, located in the Warehouse
Manager Server library. SETLIBACC determines library access. CHGSRVRDFT defines default
server security options. To run these commands, first add the Warehouse Manager Server library
(for example, SCSERVER) to your library list.

Storage CCSID Configuration

The storage CCSID value specifies the coded character set identifier that stores library, file, and
column alias names. It also stores data views, Warehouse Builder distribution sets and definitions,
and shared query information.

Thisvauemust beaSTRATEGY-supported, single-byte EBCDIC CCSID. Enter your five-digit
CCSID value, or use *CALC or *HEX to let the installation calculate it based on your i Series
(AS/400) system settings. Table 5-3 shows the EBCDIC CCSIDs supported for the Warehouse
Manager storage CCSID value.

Important: If you are using Enterprise Reporting, you must use a valid, specific storage CCSID.
Do not use a storage CCSID of 65535 or *HEX. If you are installing on adouble-byte system, use
65535 (*HEX). See “Installing and Running on a Double-Byte System” on p. 44.
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Table 5-3

Supported Warehouse Manager Storage EBCDIC CCSIDs
Country, Geographic Region, or Language Group EBCDIC CCSID
United States/Canada/Brazil 37
Multi-national #1 256
Germany/Austria 273
Denmark/Norway 277
Finland/Sweden 278
Italy 280
Spain/Latin America 284
United Kingdom 285
France 297
Greece 423, 875
Hebrew 62235
Multi-national #5 500
Korea 833
Chinese Simplified 836
Chinese Traditional 37, 28709
Thailand 838
Central Europe (Bosnia, Croatia, Czech Republic, Hungary, etc.) | 870
Iceland 871
Cyrillic Multinational 880, 1025
Japan 1027
Iran 1097
Hexadecimal (*HEX) 65535

Note: For general information about iSeries CCSIDs, including complete language and country
settings, see the IBM AS/400 National Language Support manual.

To Change Storage CCSIDs After Installation

Reinstall Warehouse Manager Server and specify a different CCSID.

Warehouse Builder Configuration

Warehouse Builder Subsystem and Library. Warehouse Builder distribution jobs run in the
Warehouse Builder Subsystem. Your current subsystem, as determined by the QCTLSBSD system
value, is displayed and should not be changed. You should use the same subsystem as your TCP/IP
subsystem.

Note: If the controlling subsystem is QBA SE, then QBASE isthe default. If the controlling subsystem
isQCTL, then QCMN isthe default. To find the controlling subsystem, type DSPSYSVAL
SYSVAL(QCTLSBSD). The current subsystem description resides in the specified library.
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Sample Database

The STRATEGY sample database, SCSAMPLE45, will beinstalled in the SCSAMPLE45 library.
You will use this database in the STRATEGY tutorials. For more information about the database,
see Appendix B in the STRATEGY Administrator’s Guide.

To Reinstall the Sample Database After Installation

You caninstall or reinstall the sample database with the RSTSMPLB command.

Finalizing Warehouse Manager Server Installation Options

At this point, you have finished setting Warehouse Manager Server installation options. If you
chose to install Essbase/400, the installation options will follow. If not, the Warehouse Manager
installation will begin.

Essbase/400 Installation Options

STRATEGY 4.5 supports Hyperion Esshase 6.1 features and functions. If you chose to install the
Essbase/400 Server, this section describes the Essbase/400 Server installation. The recommended
values are displayed; change options as required.

Essbase/400 Server Library

Specify the library in which to install Essbase/400. The screen displays current Essbase/400
libraries. Choose alibrary to upgrade, or press F6 to install anew library. The library you select to
upgrade cannot be running.

The default library name is ESSBASE. In addition, the root Integrated File System (IFS) path
used for the installation is based on the specified library name (the default is /ESSBASE).

Auxiliary Storage Pool ID. If you add alibrary, you are prompted to enter the ASP ID. Accept the
default or enter the number of the ASP from which the system should allocate storage for the
Essbase/400 installation library. IFS information installed with Essbase/400 is placed in the ASP.

Esshase/400 Server

Product Serial Number. Enter the serial number to license this copy of Essbase/400. Each serial
number is unique to oneiSeries (AS/400) because it uses the i Series serial number to validate the
Essbase license. Essbase/400 will not runiif it isinstalled on an i Series other than the one for which
the serial number was issued. If you are licensed to install multiple copies of the Essbase/400
Server, you should have a unique serial number for each installation. Two serversinstalled on the
same i Series cannot use the same serial number.
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If you do not know your serial number, enter *DEFER. However, before trying to use the
Essbase/400 Server, you must specify a serial number with the CHGESSENV command. For more
information, see Chapter 4.

EBCDIC CCSID. Essbase/400 uses the EBCDIC CCSID to represent character datawhen interacting
with DB2/400 and OS/400. The recommended EBCDIC CCSID vauefor your systemisdisplayed.
Essbase/400 converts al character data to the EBCDIC CCSID when:

m  Using an Essbase/400 OS/400 interface or command (these interfaces include the
Essbase/400 Server, ESSCMD command interface, MaxL command interface, and
Warehouse Builder run-time interfaces)

m Loading datausing SQL and referencing i Series physical or logical files

m Writing messages to the OS/400 job log

You can specify only one EBCDIC CCSID for each Essbase/400 Server. The Essbase/400 Server
supports single-byte and double-byte CCSIDs. If your environment requires double-byte character
support, see “Installing and Running on a Double-Byte System” on p. 44.

If you installed Warehouse Manager Server, the EBCDIC CCSID for Warehouse Manager Server
must be the same as the EBCDIC CCSID for all of the Esshase/400 serversit uses. Multiple
Essbase/400 servers must all use the same EBCDIC CCSID if they are accessed through the same
Warehouse Manager Server.

ASCII CCSID. The Essbase/400 Server uses the ASCII CCSID to represent character data when
interacting with Essbase/400 client software (for example, Analyzer, Excel add-ins). The
recommended ASCII CCSID value for your system is displayed.

Theinstallation calculates this value based on the EBCDIC CCSID value. For example, if the
EBCDIC CCSID is 37, the matching ASCII CCSID is 1252, which supports Western European
languages (English, French, German, Italian). For the recommended EBCDIC and ASCII CCSID
pairs, see Table 5-2 on p. 36.

You can specify only one ASCII CCSID for each Essbase/400 server. Therefore, all PC clientsthat
access the Essbase/400 Server must use the same ASCII CCSID. The ASCII CCSID should be
supported by Windows (ANSI code). If you do not use an ANSI-equivalent CCSID, characters sent
from the Essbase/400 Server may appear incorrectly.

Essbase/400 converts all character data to the ASCII CCSID when:

m  Communicating with a PC client (for example, Analyzer, Excel add-ins)

m  Saving and loading Esshase/400 outlines (.otl), load and build rulefiles (.rul), and calculation
script files (.csc) to the Integrated File System (IFS)

Note: For general information about i Series CCSIDs, including complete language/country
settings, see the IBM AS/400 National Language Support manual.

Server Threads. Enter the maximum number of server threads that can be created by Essbase/400
when an application is started. The default is 5. This value should be the average number of
concurrent report regquests expected for each application.

IP Address. Enter the | P address that Essbase/400 Server should use to listen for incoming client
reguests. You must enter avalue for this option. If you do not know the value, enter *DEFER.
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However, before using Essbase/400, you must specify an |P address using the CHGESSENV
command. The value must be unique for each Essbase/400 library.

Notes:

m If you areinstalling over an existing library, the current IP address is displayed.

m  Todisplay the P addresses configured on your i Series (A S/400), enter the command CFGTCP
and choose option 1.

m Enter *ALL if you have only one Essbase/400 library and it listens for incoming client TCP/IP
requestsusing all 1P interfaces configured on the i Series. When your i Seriesis configured with
multiple TCP/IP interfaces connected to different | P subnetworks, specifying *ALL prevents
you from running multiple copies of Essbase/400 on asingleiSeries.

To Change the Essbase/400 Options After Installation

To Change the Product Serial Number: Use the CHGESSENV command.
To Change CCSID Values: See the STRATEGY Administrator’s Guide.
To Change Server Threads: Use the CHGESSENV command.

To Change the IP Address: Use the CHGESSENV command. The value must be unique for each
Essbase/400 library.

Starting Esshase

If you did not provide a serial number or |P address, you will not see this screen. Enter Y if:
m You areinstalling Essbase/400 in anew library

m You want toinitialize the Essbase/400 security file

® You did not choose *DEFER for the product serial number and 1P address.

Note: The only time the Essbase/400 Server is started automatically isif you choose Y at this
prompt.

Enter and remember the following security information:

Company Name. Enter the name of your company. This information will be displayed in the
registration message when you start Essbase. The name must be at least three letters long.

User ID. Enter the Essbase administrator’'s user D, which isneeded for security administration and
ending the server. ThisID is not the OS/400 user ID. The Essbase user ID must be at |east three
characterslong. Write down your user ID.

Password. Enter the password for the Essbase administrator’s user ID. The password must be at
least six characters long and different from the user ID. Write down your password.

To Start Esshase After Installation

For more information, see the STRATEGY Administrator’s Guide.
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Finalizing Essbhase/400 Server Installation Options

You have finished setting Essbase/400 installation options. If you deferred any options, configure
them later with the CHGESSENV command. To start installation, press Enter.

Installing and Running on a Double-Byte System

This section applies to countries using a double-byte character set (DBCS) to represent character
data (for example, Japan).

Using the Correct CCSID

If you areinstalling STRATEGY on a system with DBCS support, use a CCSID that supports
lowercase English characters or 65535 (*HEX). If you set the CCSID value to 65535, the iSeries
choosesadefault CCSID for the job based on the job’slanguage identifier. However, make surethat
the default CCSID supports lowercase English characters (ENU).

For example, if thejob CCSID is65535 (*HEX) with alanguage identifier of JPN, 5026 becomes
the default CCSID. But for Essbase/400, 5026 does not support standard lowercase English
characters and is not supported for Essbase/400 installation or operation.

If you must run an Essbase job under a*HEX CCSID, change thejob’s language I D so that 5026
isn't the default CCSID. For example, using ENP (English uppercase) will calculate a default
CCSID of 37.

Using the Correct EBCDIC CCSID

The CCSID of the iSeries job running the Essbase/400 Server or command interface must be
the same as the Essbase/400 EBCDIC CCSID or 65535 (*HEX). Otherwise, you may get
unpredictable results.

Any job that performs Essbase/400 operations (for example, starts the server, ESSCMD, MaxL,
Warehouse Builder) must also use the same EBCDIC CCSID that Essbase/400 uses or 65535
(*HEX).

Use 65535 only when data stored in DB2/400 tables for dimension building or data loading have
the wrong CCSID for the data stored in them.

When using 65535 for the Essbase/400 Server job CCSID, the data contained in the DB2 files
must use the server EBCDIC CCSID. For more information, see the STRATEGY Administrator’s
Guide.

To change CCSIDs after Essbase/400 isinstalled, see the STRATEGY Administrator’s Guide.

Changing CCSIDs for Profiles and Jobs

The CCSID can be changed once for each OS/400 user by changing the OS/400 user profile or by
changing the current job each time a user signs on.
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To Change the CCSID for a User Profile

If you have *SECOFR authority, use the following command. The ccsidvalue should be a CCSID
that supports lowercase English characters or 65535 (*HEX).

CHGUSRPRF USRPRF(userid) CCSID(ccsidvalue)

After the command is run, the user specified by userid should sign off the system and back on.

To Change the CCSID for a Job

Use the following command each time that you sign on to the system.

CHGJOB JOB(*) CCSID(ccsidvalue)

Setting Up Your PC for Double-Byte Character Data

If you are using a double-byte character set (DBCS) to represent character data (for example,
Japanese or Chinese), use the following steps to set up your PCs:

» Install Client Accessversion V4RS or later from your iSeries. The path is:
/qibm/ProdData/ CA400/Express/Install/Image

» Install STRATEGY as described in this chapter and Chapter 6.

» Configure adata source as described in Chapter 8.

» To open the AS/400 Test Connection, from the Windows Start menu, choose:
Programs

ShowCase STRATEGY 4.5
AS/400 Test Connection

» Highlight your data source, and click Setup.
This opens the ShowCase ODBC Setup dialog box.

» Click the Translation tab, and select Convert OEM to ANSI Characters, as shown in Figure 5-1.



46

Chapter 5
Figure 5-1
Convert OEM to ANSI characters
Connectionl Defaultsl Optimizationl Logeing Translation
Data Source Hame: |Lucy Supportd
Description: |
W Torveert OEM to AMSI Characters
ok | #ewt | Az
» Click OK.

» Click Global Settings.
This opens the Settings dialog box.

» Click the Double Byte tab, and choose the correct translation for your data, as shown in Figure 5-2.

Figure 5-2
Choosing the correct translation

Licensing | Gache | Print Files | Wersion | Microsoft Trace Double Byte

— Laneuage Support

Fleaze select the appropriate laguage support for wour A5/400

MOTE: If wou are having difficulty entering lower caze collection, table, or
column hames vou will need to zelect support for upper ahd lower case
Enelish (3GSID 50353

{+ Double byte with upper case English (026X
" Double byte with upper AMD lower caze Enelizh G035

ok | #evtn | amme | Az |
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» When you open STRATEGY for the first time, you will be prompted to log on to the i Series with
Client Accessto load EBCDIC to ASCII translation tables. See Figure 5-3.

Figure 5-3
Sign on to load translation tables

Sienon ta A5/400

E To access thiz resournce, you need to signon to the 45400 syztem.

Rezource: ICode page conversion table [343 to B02E)

System: LUCyY

User ID: I
Password: I

0K I Cancel |

After thisinitial connection, the tables will exist on your PC.
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Installing and Uninstalling
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Before You Begin

If you are upgrading to STRATEGY 4.5, read the STRATEGY 4.5 Upgrade Guide at
http://support.spss.com/upgradeinfo/.

The STRATEGY setup will allow you to automatically uninstall versions of STRATEGY 3.0
and later. If the STRATEGY setup detectsapreviousinstallation, you will be asked if you want
the previous version removed. The STRATEGY setup will display the older products and
installation path as defaults. If you choose not to remove the previous version, you must choose
an instalation folder other than the existing path.

Note: A 4.5 silent installation will automatically uninstall versions 3.0 and later.

If you have versions of STRATEGY prior to 3.0, you must uninstall the client applications
manually. Installing STRATEGY 4.5 into the same folder asa 2.x installation will not fully
replace the previous version. See the STRATEGY 4.5 Upgrade Guide at
http://support.spss.com/upgradeinfo/.

Beforeinstalling PC software, the server software must beinstalled and running. See Chapter 5.

Each PC that installs STRATEGY must have adifferent name. For PC naming guidelines, see
“Transferring or Removing a PC License” on p. 30 in Chapter 4.

Enterprise Server Considerations

Any PC with the Enterprise Server installed must also have Query and Report Writer installed to
run scheduled and dynamic reports.

The Enterprise Server has the following restrictions:

It must be installed on computers running Windows NT 4.0, Windows 2000, or Windows XP.
The network workstation installation option is not available.

49
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Hyperion Analyzer Considerations

STRATEGY Analyzer is based on Hyperion Analyzer 4.0. If you use Hyperion Analyzer 5.0 and
want to access relational datain Hyperion Analyzer or export groups from STRATEGY Analyzer
to Hyperion Analyzer, you will need the Virtual Cube support and the Group Export tool. You can
install them from the STRATEGY CD.
To install Hyperion Analyzer Support:

» Fromthe STRATEGY CD, start the client installation.

» Inthe Components list, select Hyperion Analyzer Support, as shown in Figure 6-1.

» Inthe Subcomponentslist, select Essbase Runtime Client. Support for Virtual Cubes and the Group
Export tool is optional, and you may choose to desel ect these options.

Figure 6-1
Hyperion Analyzer Support
Select Components E
Components Select the components/subcomponents pou want to
inztall, Clear the components/zubcomponents pou do not
Query 1883k want to install
Report ‘writer Te40 K
Analyzer 11453 K Subcompanents
W arehouze Builder 2863 K Funtime Clisnt
w2 Runtime Client
" areh &l 4180k
SIEnousE Managst [] Vittual Cube Support 1850 K
Essbazed0l Client 47291 5 Ewnort Lt 10636 K
Orline Manuaks 408K roup Export Ltity
Samples 29299 K
Enterprize Server 29808 K,
Hypenan Analyzer Support TN 2K
— Dezcrphion
“““““ Thiz does nat install Huperion Analyzer. ===
Select ta inztall support filez/toolz required by or ta use
: i conjunction with Hyperion Analypzer (available on a
Space Required: 193116 K separate CDJ.
Space Available: 3217802 K

< Back I Mest > Cancel

Network Installation Considerations for Analyzer Users

Providing Server Information

If you perform a network installation to allow users to run setups from the network location, you
will be asked to provide information for Warehouse Manager Server. Thisinformation will be
entered inthe users’ registrieswhen they install Analyzer products, alowing them to automatically
connect to Warehouse Manager Server. You may skip this information when you install, but you
must enter it the first time that you connect to Warehouse Manager Server from Analyzer or
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Analyzer for the Web. If you do not use Analyzer products, you can skip this screen by clicking
Next. See Figure 6-2.

Figure 6-2
Entering Warehouse Manager Server information during network installation

Warehouse Manager Server Information [ x|

Setup will configure an Warehouse Manager Server on your
uzer's PC when they install Please edit the &5 /400 [P address
and edit the server name and TCF Port if necessary.

Click Mext to continue. Clicking Cancel will exit the install.

Server  |SCSERVER

IP Address: I

TCP Port.  [43415

< Back I Hest » I Cancel |

Server name. Represents Warehouse Manager Server in the Server dialog box when Analyzer is
first started. The default nameis SCSERVER. Enter your custom information below.

My server name:

iSeries (AS/400) IP Address. | Pnumber of theiSerieswhere Warehouse Manager Server isinstalled.
Enter your custom information below.

My iSeries (AS/400) | P address:

TCP Port. Port number specified during the installation of Warehouse Manager Server on the
iSeries. Enter your custom information below.

My TCP port:

Granting Write Authority to the Network Directory

If you install Analyzer to a network directory so users can perform workstation installations, you
must also grant users write authority to the network directory. Users must have write access to the
network directory to save slides or slide shows stored in the SSHOW network directory.

If you do not want your users to have write access to the network directory, use the following
procedure to enabl e users who perform workstation installations to store slides and slide shows on
their local hard drives:

» Createadirectory called SSHOW on the local hard drive.

» From the Windows Start menu, choose Run.
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» Type REGEDIT and locate
HKEY_CURRENT_USER\SOFTWARE\SHOWCASE\ANALYZER\SETTINGS SLIDESHOWPATH.

» Right click (Default), and click Modify.

» Inthe Value Datadialog box, change the path to point to the SSHOW directory created in the first
step—for example, C:\PROGRAM FILESSHOWCASE STRATEGY\SSHOW.

» Click OK.

Analyzer for the Web Considerations

Usersdon’t have to install Analyzer for the Web software if they have TCP/IP configured and a
supported Web browser on their PCs. After installing and configuring the server, instruct usersto
point their browser to the designated Web page (1P address or URL). The Java applet will run
automatically.

Essbase Client Considerations

When you install Essbase/400 components, the files are installed in the STRATEGY folder (for
example, ShowCase STRATEGY\bin) and the environment settings are updated to point to that
folder. After installation, you can uninstall any previous Esshase folders.

SOL Drill-Through

After you install STRATEGY, you caninstall SQL Drill-Through. On the STRATEGY CD, go to
the\Sgldrill folder, and run Setup.exe.

Running Installation Multiple Times

If yourun theinstallation at different timesto install different STRATEGY components, it will use
the same folder in which STRATEGY was first installed. Thiswill log installed software for easy
uninstallation.

Accessing the STRATEGY CD via a Network

Important: When you accessthe STRATEGY CD viaanetwork, map adrivetothe CD rather than
accessing it via Network Neighborhood. Network Neighborhood uses the Universal Naming
Convention, which may occasionally cause path errors in various products, including Adobe
Acrobat.
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Installing STRATEGY to PCs

There arethree waysto deploy STRATEGY. Choose the best method for your situation. Step-by-step
instructions are in the following sections.

Important: Do not use the Microsoft Add/Remove Programs application to initiate the
STRATEGY installation.

CD installation. Installs STRATEGY from the CD to user PCs. If STRATEGY users don’t have
CD-ROM access, you can copy the contents of the CD to a network drive and have users install
it from there.

Network installation. Installs STRATEGY to the network so users can install or run STRATEGY
from ashared location. A network install ation allowsyour usersto choose either alocal installation
toinstall STRATEGY totheir PCsor aworkstation installation that uses a minimum amount of the
user's hard drive space.

Silent installation. Installs to the user PCs setup options that the administrator records. This method
requires no user intervention; dialog boxesinform the user of the installation progress. See Chapter 7.

CD Installation

Important: We recommend disabling all antivirus softwar e beforeinstalling STRATEGY. Some
antivirus software changes file properties and could prevent correct installation.

» Insert the STRATEGY CD into alocal or shared CD-ROM drive. If neither isavailableto all users,
copy the CD to the network, and have users click the Setup.exeicon or file from the network CD
image.

» If you'reusing alocal CD-ROM and autorun is enabled, the STRATEGY installation screen
will appear.

» If theinstallation screen doesn’t appear, click the Setup.exe icon or file on the CD, or:
m  From the Windows Start menu, choose Run.

m Inthe Rundialog box, type G:\Setup.exe
(where G istheletter assigned to the local or network CD-ROM drive.)

m Click OK.
» Choose from the STRATEGY installation screen options.

Note: Adobe Acrobat Reader is required to view some STRATEGY documentation. If necessary,
you can download it free of charge from www.adobe.com or install it from the CD. Click Install
Adobe Acrobat Reader.

Note: To find the Read Mefilg, click Browse the CD-ROM, and click SCReadMe.txt.
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Network Installation

During network installation, the administrator installs the STRATEGY setup and client filesto a
shared network location. End users can then run Setup.exe to install filesto their local PC (local
installation) or access files from the network (workstation installation.)

Step 1: Install STRATEGY to the Network
Follow the instructionsin “CD Installation” on p. 53. In the Install Type dialog box, choose Install
to the network.

Figure 6-3
Installing to the network

Install Type E

Chooze if you want to perform a local install or a netwark: install..

¢ Back I Mest > I Cancel |

Note: If you plan to keep multiple versions of STRATEGY software on the network, you may want
to retain the release version in the default folder path.

Step 2: Install STRATEGY Files to User PCs

Users have two options:
m Local installation. Install STRATEGY filesto the PC.

m  Workstation installation. Install only required filesto the PC and point to the software on the
network. The product, online Help, sasmplefiles, etc., reside on the network.
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To Perform a Local or Workstation Installation

» Using Windows Explorer, find the network folder in which STRATEGY wasinstalled, and
double-click the Setup.exeicon or file.
or
From the Windows Start menu, choose Run. Browse to the network folder wherethe STRATEGY
Setup.exefileislocated. Open the Setup.exe file, and click OK.
Note: To prevent time-out issues due to network performance, add -SMS (all capital |etters) to the
command—for example: setup.exe -SMS.

» The setup will guide you through the installation. At the Install Type dialog box, select the
appropriate option (local or workstation).

Uninstalling STRATEGY

This section explains how to uninstall STRATEGY 4.5 PC software. If you want to uninstall any
release prior to STRATEGY 4.5, seethe STRATEGY 4.5 Upgrade Guide at
http: //support.spss.com/upgradeinfo/.

To Uninstall STRATEGY 4.5 from PCs
» From the Windows Start menu, choose:

Settings
Control Panel

» Double-click Add/Remove Programs.
» Choose ShowCase STRATEGY 4.5, and click Add/Remove.

» After uninstalling, reboot the computer before installing STRATEGY again.

To Uninstall STRATEGY 4.5 from the Network

You must manually delete the folder from the network drive.
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Setting Up Silent Installations

Silent installationsallow userstoinstall STRATEGY with installation options specified in advance
and saved in aresponse file (*.iss) by an administrator. Thisinstallation deploys STRATEGY to
many users and ensures that the same software is installed on each PC. During the silent
installation, users see messages about the progress, but they cannot make installation choices.
Figure 7-1

Silent installation

2

Administratar records the STRATEGY
SETUP.EXE from the Metwaork
Directory and chooses installstion
options for all PCs.

Option=s are recorded ina SETUP.ISS
filz on the Administrator PC.

3

Administratar copies the
SETUP ISS file to the
Metwark Directary.

Adminiztrator PC

1 User PCs
Adminiztratar installs the
STRATEGY SETUP.EXE file “
tothe netwoark in a shared 4
lacation (Metwork Directory]. Users access the Metwork
— Directory and run a command that
calls the SETUP ISS file and
[”][”]”HH zilently installs STRATEGY to
their PCs.
oooonan

Metwork Directory
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Before

You Begin

Important: Enterprise Server can be installed only on computers running Windows NT 4.0,
Windows 2000, or Windows XP. Attempted installation of Enterprise Server on a Windows 98
machine will fail.

m A STRATEGY 4.5silent installation will automatically uninstall versions of STRATEGY 3.0
and later. See the STRATEGY 4.5 Upgrade Guide or go to
http: //support.spss.com/upgradeinfol.

® You can perform silent installations on PCs running Windows 98, Windows NT 4.0, Windows
2000, or Windows XP.

m  To begin recording silent installation options, you do not have to have STRATEGY installed
on your PC.

m  When you record silent installation options, STRATEGY does not get installed on your
computer. However, when you run the silent installation, it will be installed on the PC that
you're using.

m  TheBack button is not active when you record asilent installation. If you need to go back and
change something, you must restart recording the installation from the beginning.

m A silent installation can be done only after STRATEGY isinstalled on the network. It cannot
be done after copying the CD to the network.

m Each PC using silent installation must have a unique PC name. If you use Microsoft
Networking, the PC’'s Microsoft Networking name will be detected automatically.

If you don't use Microsoft Networking, the PC name remains undefined. See Chapter 4 for more
information.

Creating a Silent Installation

>

To install the software for which you want to create a silent installation, follow the instructionsin
Chapter 6.

From the Support Web site at http://support.spss.conv, apply current patchesto the network folder.
Apply the Network Installation patch last.

From the Windows Start menu, choose Run and enter the command:
e:\sourcefoldensetup.exe -r

where e:\sourcefolderis the path of the network folder in which you installed software in the first
step. This command does not install STRATEGY software on the PC.
Press Enter.

Note: If you do not use the setup.exe -r command asinstructed above, the software will beinstalled
on your system. No setup.iss file will be created.
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» Follow the onscreen instructions to select installation options for users who conduct the silent
installation. The path and options that you select are recorded in your C:\Windows folder in a
setup.issfile.

» Copy the setup.issfile to the network folder in which you installed software in the first step.

» To perform the silent installation, give your users the following instructions. Alternately, you can
create a batch file that automatically runs the command.

A filecalled setup.log is created in the sourcefolder when the silent installation runs. If installation
is successful, the value of ResultCode inthelogisO.
For users with write authority to the sourcefolder:

From the Windows Start menu, choose Run and enter the command:
e:\sourcefoldensetup.exe /s

where e:\sourcefolder isthe path of the network folder in which you installed software in the first
step.
If installation is successful, the value of ResultCode inthelogisO.

For users without write authority to the sourcefolder:

From the Windows Start menu, choose Run and enter the command:
e:\sourcefoldensetup.exe /s -f2path\logfilename

where:

m e:lsourcefolderisthe path of the network folder in which youinstalled softwarein thefirst step.
m path specifies where the log file should be created.

m Jogfilename isthe name of thelog file.

Using the command example above, the command would be:

e:\sourcefolderlsetup.exe /s -f2c:\temp\setup.log

Creating Multiple Silent Installations

It is possible to create multiple silent installations that install specific STRATEGY applications
from the same network location. To do this, you must create a separate response file (*.iss) to
initiate each silent installation.

» Follow thefirst five steps of “ Creating a Silent Installation” on p. 58.
» After the setup.issfileiscopied to the network folder in which you installed the software, rename

the file using a unique name and retaining the .iss extension. For example, if you want a user to
install only Query and Report Writer, you could rename the setup.iss file rwquery.iss.
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The path to the renamed .iss file must be used as an argument and a command line switch in the
command line call.

Note: If thereis a space in the folder name, place quotation marks around the path name.
<Path to setup.exe> <Path to new .iss> /s -f1<Path to new .iss> (optiona -f2<Path to setup.log >)
Using the command exampl e above, this would be:

"e:\source folder\setup.exe
f2c:\temp\setup.log

e:\source folder\rwquery.iss" /s -f1"e:\source folder\rwquery.iss" -

This alows the setup program to receive the name of the renamed .issfile as an argument and ook
for recorded resultsin thefileif your user’s PC environment requires different actions than the PC
used to record the installation.

Silent Setup.log File

Setup.log isthe default name for the silent setup log file. It will be created in sourcefolder when the
silent installation runs. If users do not have write authority to sourcefolder, the user should create a
setup.log file on each PC. See*” Creating a Silent Installation” on p. 58.

The setup.log file contains three sections. The first section, [InstallShield Silent], identifies the
version of InstallShield Silent used in the silent setup. It also identifies the file asalog file.

The second section, [Application], identifiestheinstalled application’sname and version, and the
company name.

The third section, [ResponseResult], contains the result code indicating whether the silent setup
succeeded. Aninteger valueis assigned to the ResultCode keynamein the [ResponseResult] section.

Install Shield places one of the following return values after the ResultCode keyname:

0 | Success

-1 | General error
-2 | Invalid mode
-3 | Required data not found in the Setup.issfile

-4 | Not enough memory available

-5 | File does not exist

-6 | Cannot write to the response file

-7 | Unableto write to thelog file

-8 | Invalid path to the Silent response file

-9 | Not avalid list type (string or number)
-10 | Datatypeisinvalid
-11 | Unknown error during setup

-12 | Didog boxes are out of order

-51 | Cannot create the specified folder

-52 | Cannot access the specified file or folder
-53 | Invalid option selected
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The following is an example of a setup.log file for a successful silent setup of InstallShield:

[InstallShield Silent]
Version=v5.1.000
File=Log File

[Application]
Name=STRATEGY
Version=4.5
Company=SPSS
Lang=0009

[ResponseResult]
ResultCode=0

Tips and Troubleshooting

I receive an error message that reads, “Not enough disk space.”

Thisislikely an erroneous message, and the PC has enough disk space. There are two possible
solutions:

m  Copy the network installation to any loca drive and install from that drive.
or

m  Record theinstallation from a different PC.

Can | perform a silent installation into a folder with a space in the name?

Yes, if you put quotation marks around the path name. Here is an example of amultipleinstallation
with the -f1 and -f2 parameters:

"N:\Applications\ShowCase STRATEGY\4.5\setup.exe" "N:\Applications\ShowCase
STRATEGY\4.5\desktop.iss" /s
-f1"N:\Applications\ShowCase STRATEGY\4.5\desktop.iss" -f2¢:\temp\setup.log

Will the silent installation install STRATEGY on the PC that | record from?

When you record the silent installation options, STRATEGY does not get installed on your
computer. However, when you run the silent installation, it will be installed on the PC that you're
using.

If youwant to silently install STRATEGY on the PC that you record from, refer to the sixth step
in “Creating a Silent Installation” on p. 58.
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Setting Up an ODBC Data Source

To set up data sources, use Microsoft ODBC Administrator (odbcad32.exe) installed with
STRATEGY PC software. You can accessit viathe STRATEGY group on the Windows Start
menu.

Relational components. Set up a ShowCase ODBC data source on each PC that accesses iSeries
(AS/400) Warehouse Manager Server through STRATEGY applications. You will need:

m iSeries|P address
m  Warehouse Manager library port number

Multidimensional components. PCs that use only multidimensiona query components (Analyzer
against Essbase, Essbase reporting in Query/Report Writer, or the Essbase Spreadsheet Add-ins)
do not require an ODBC data source.

Non-DB2 data sources. Set up data sources to access the following:
m  Microsoft Access and Excel

m  Microsoft SQL Server

m LotusDomino

m Oracleon AlX, Windows NT, or Windows 2000

For non-DB2 data source setup information, see the non-DB2 guides at http://support.spss.conv.
After you log in, click Documentation and then click STRATEGY Manuals.

Adding a ShowCase ODBC Data Source

You should add a ShowCase ODBC data source if:

m Thisisyourfirst STRATEGY installation and setup and/or you received the following message
at the end of the PC installation: Setup has not created a sample ShowCase ODBC data source.

m Youinstalled Warehouse Manager Server to anew library and want to access both the new and
old Warehouse Manager libraries.
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To add a ShowCase ODBC data source:

» From the Windows Start menu, choose;

Programs
ShowCase STRATEGY 4.5
Microsoft ODBC Administrator

Figure 8-1
Microsoft ODBC Data Source Administrator dialog box

&10DBC Data Source Administrator
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» Click Add.

» Inthe Create New Data Source dialog box, select ShowCase ODBC and click Finish.

Figure 8-2
ShowCase ODBC Setup dialog box
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Data Source Name:
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» Enter adata source name. Adding a description is optional.

Note: If you are sharing queries, using the same data source name on all PCs will make sharing
queries easier for novice users.

» Enter your iSeries (AS/400) | P address.

» Enter your Warehouse Manager Server TCP port number. The default is 43419.

Note: If you don’t know the TCP port number, use the i Series (AS/400) WRKSRVTBLE command
and search for SCSERVERIlibname, where libname is the Warehouse Manager Server library name.

» Click oK.

Modifying a ShowCase ODBC Data Source

You can modify a ShowCase OCBC data source if Warehouse Manager Server was installed to a
new library and you do not want to access the old library—or if you need to change your data
source name, | P address, or TCP port number.

To modify a ShowCase ODBC data source via Microsoft 0DBC Administrator:
» From the Windows Start menu, choose:
Programs

ShowCase STRATEGY 4.5
Microsoft ODBC Administrator.

You will see ascreen similar to Figure 8-1.

» Select the data source that you want to modify and click Configure.

A ShowCase ODBC Setup dialog box similar to Figure 8-2 appears.
» Modify the ODBC setup information as necessary.
» Click OK.

To modify a ShowCase ODBC data source via AS/400 Test Connection:
» From the Windows Start menu, choose:

Programs

ShowCase STRATEGY 4.5
AS/400 Test Connection

» Select the data source that you want to modify.
» Click Setup and change the information as necessary.

» Click OK.






Connecting to the iSeries (AS/400)

_JQ Windows NT Ewplorer
_g Admimistrative T ools [Commarn)
= Adobe
= Adobe Acrobat 4.0
J;i, Java 2 Runtime Environment
=) Java tandan ticty w1, 3.0_|
Jawa 2 SDK Standard Ed 1.3.0_02
_g Microsoft Office Taols
_;9 Microsoft Proxy Client
_g Microzoft Reference
E] Wew Office Document _% Microzoft Visual Studio £.0
@ Open Office Document _g Mouset/ are
KwikPhone = Phware
& r q (= FaboHELP Office
Tagrarns .
- ;" # 5 RUMBA S5NT Folder
*
o B s RATEGY
j Documents = .
_E.'.j. - , = SPSS for Windows
1 Seftings -
— g = Startup
@ Eind ] =
& ; | = Vantive
E
Icrosoft Access
71 E i Micrasoft A
ur....

= B8 Microsoft Excel

E ssbase Books

Online Help

STRATEGY Books

Analyzer Designer

Analyzer

A5400 Test Connection
Enterprize Server

E zzbazed 00 Application M anager
Essbased00 EzsCmd

MasL Command Shell
Microgoft ODBC Admikistrator
Query

Repart 4riter

Warehouse Builder

[ ylE S S e

* v T w v v w w v w

%
54
8

Warehouze Manager

b
3
3
3
]
]

Connecting to Warehouse Manager Server

Chapter

You can connect to Warehouse Manager Server with any of the STRATEGY PC products or with

the AS/400 Test and Configure application.

Connecting with STRATEGY PC Applications

» ToopenaSTRATEGY application, from the Windows Start menu, choose:

Programs
ShowCase STRATEGY

67



68

Chapter 9

Query

>

Open Query and from the menus, choose:

File
New
Query

If you have not specified a default data source, Query will prompt you to select one. Select adata
source and click Next.

In the ShowCase ODBC L ogon dialog box, enter your user ID and password and click OK.
If your logon is successful, the Tables dialog box appears and your PC is connected to Warehouse

Manager Server. If your logon is not successful, see “ Connecting with the AS/400 Test and
Configure Application” on p. 69.

Report Writer

>

Open Report Writer and from the menus, choose:
File
New

In the Choose Report Style dialog box, select Columnar Report and click OK.

If you have not specified adefault data source, Report Writer will prompt you to select one. Select
adata source and click Next.

In the ShowCase ODBC L ogon dialog box, enter your iSeries (A S/400) user I D and password and
click OK.

If your logon is successful, the Tables dialog box appears and your PC is connected to Warehouse
Manager Server. If your logon is not successful, see “ Connecting with the AS/400 Test and
Configure Application” on p. 69.

Warehouse Builder

>

Open Warehouse Builder and select adata source to use as a control server. Thisisthe Warehouse
Manager Server library in which you want to store your distribution definitions. Click OK.

If you have not specified a default data source, Warehouse Builder will prompt you to select one.
Select a data source and click OK.

In the ShowCase ODBC Logon dialog box, enter your i Series user ID and password and click OK.
If your logon is successful, the Warehouse Builder Assistant dialog box appears and your PC is

connected to Warehouse Manager Server. If your logon is not successful, see Connecting with the
AS/400 Test and Configure Application” on p. 69.



69

Connecting to the iSeries (AS/400)

Warehouse Manager Client

>

>

Open Warehouse Manager Client and select the data source to which you want to connect.

On the File menu, choose Connect, or click the Connect tool.

In the ShowCase ODBC L ogon dialog box, enter your iSeries user | D and password and click OK.
If your logon is successful, your user 1D appears in parentheses after the data source and your PC

is connected to Warehouse Manager Server. If your logon is not successful, see “ Connecting with
the AS/400 Test and Configure Application” below.

Connecting with the AS/400 Test and Configure Application

The AS/400 Test and Configure application tests the ODBC data source setup. Use it to:
m Verify your connection to the correct system and library.
®  Add, edit, or remove a ShowCase data source.

The Test and Configure application does not test the special checks made when STRATEGY
software connects to the iSeries (AS/400). That is, there are times when Test and Configure will
connect but a product will not, such as when a user is not authorized to use a product or when an
application password has expired.

To open the AS/400 Test and Configure Application:

From the Windows Start menu, choose:

Programs
ShowCase STRATEGY 4.5
AS/400 Test Connection

Troubleshooting Warehouse Manager Connection Failures

Troubleshooting Query and Report Writer

m  Make sure that you entered your password correctly.
m Verify your default data source:

Open Query and from the menus, choose:

Tools
Options

Click the Data Source tab, and verify your default data source.
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Troubleshooting TCP/IP

m  Verify your IP address:
Use the Microsoft ODBC Administrator to determine whether your 1P address is valid.
At the MS-DOS prompt, type PING ipaddress, where ipaddress is the | P address you want to use.

If youreceiveareply similar to Reply from 172.16.1.84: bytes=32 time=84ms TTL=64, your | P address
isvalid and the TCP/IP connection is working.

If you receive the message Request timed out, your | P address may be incorrect or TCP/IP may not
be configured correctly on either your PC or the server.

For more information, see Chapter 8.
m  Verify your library port number:
At the iSeries command line, type WRKSRVTBLE and press Enter.

In the Port column, look for the port number you want to use. The port’s service entry should be
SCSERVER serverlib, where serverlib is the name of the Warehouse Manager Server library. If you
do not find the port, look for the correct library name under Service and check the correct port
number for that library.

Tools
Options

m Verify that IBM's TCP/IP is active on your iSeries (AS/400):

At the iSeries command line, type WRKACTJOB JOB(QTCPIP) and press Enter.

If you cannot find the job, type the STRTCP command and press Enter to start TCP/IP on the server.
For more information on starting and stopping TCP/IP, see the STRATEGY Administrator’s Guide.
For more information on TCP/IP problems, see the IBM TCP/IP manual.

m Verify that the TCP/IP master job has started on the server:

At theiSeriescommand line, type WRKACTJOB JOB(serverlib), where serverlib isthe name of the
Warehouse Manager Server library, and press Enter.

There should be an entry in the subsysterm/job column with the same name as the library in which
Warehouse Manager Server isinstalled. Use option 5 to work with this job and then option 11 to
display the call stack. The program TCPMASTER in the library containing the installation should
be the first program on the stack (use F11 to change the display until you see the program and
library names).

For more information on using TCP/IP with STRATEGY, see the STRATEGY Administrator’s
Guide.

m [f IBM TCP/IP and the TCP/IP master job are bhoth active, complete the steps listed helow:

At the iSeries command line, type:
CHGJOBD JOBD(serverlib/SCTCPSRV) LOG(4 00 *SECLVL) LOGCLPGM(*YES)

where serverlib is the name of the library in which Warehouse Manager Server isinstalled.
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» Runthefollowing iSeries commandsto attempt aconnection test, and note the i Series system date
and time:

DSPSYSVAL SYSVAL(QDATE)
DSPSYSVAL SYSVAL(QTIME)

» To view spooled filesin the QUSER spooled file list, type the i Series command WRKSPLF
SELECT(QUSER).

» PressF6 to go directly to the bottom of the spooled list. There should be a spooled file named
QPJOBLOG with auser dataattribute of SCTCPSRV. Press F11 until the display showsthe creation
date and time. L ook for the date and time of the connection failure. If you find amatching spooled
file, skip the next two steps and resume the process.

Note: Almost all connection failurejob logs can be found in the QUSER spooled filelist. However,
certain types of errors may suddenly terminate the connection directly after theinitial connection
is complete, and thus the job log may be in the profile’s spooled file list. To find the spooled file
for the ODBC profile, complete the next step.

» |f you do not see a spooled file matching the date and time of the connection failurein the QUSER
spooled file list, use the i Series command WRKSPLF SELECT (odbcprofile),
where odbcprofile is the iSeries user profile specified in the connection dialog box.

» Repeat the step beginning with “Press F6.”

» Useoption5to display the spooled file from the spooled filelist. Page down and ook for messages
indicating the cause of the connection failure.

» If you need help in determining the cause of the connection failure, contact ShowCase Support. A
copy of the job log for the failing connection will help to diagnose the connection failure.

Note: Once the connections are working, run the following command to avoid generating job logs
for al connections:

CHGJOBD JOBD(serverlib/SCTCPSRV) LOG(4 00 *NOLIST) LOGCLPGM(*NO)

where serverlib is the name of the library in which the server isinstalled.

Note: If you need further assistance, contact ShowCase Support (see Chapter 1 for details).

Connecting to Esshase/400

Before connecting to Essbase/400 Server, use the WRKACTJOB command to verify that the server
isrunning. The server job will have anameidentical to the job description name, ajob type of BCH,
and afunction of PGM-ESSBASE. Applications run under separate jobswith the job name identical
to the application name and a job type of BCI.
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To connect to Esshase/400 Server from Esshase/400 Application Manager:
Open Essbase/400 Application Manager.
On the Server menu, choose Connect.

In the Essbase System Logon dialog box, enter or select the TCP/IP address or the host alias name
of your Essbase/400 server in the Server drop-down list.

Enter your user name and password, and click OK.

If your logon is successful, your PC is ready to use Essbase/400 Server. If your logon is not
successful, see “ Troubleshooting Essbase/400 Connection Failures’ below.

Troubleshooting Esshase/400 Connection Failures

Problem. In the Application Manager’s Esshase System L ogon dial og box, no servers appear in the
Server drop-down list.

Solution. Originally, the server 1P or hosthame must be manually entered in the Server drop-down
list. After avalid connection is established, the server IP and hostname are stored.

Problem. The following error message is displayed: Network Error (10060): Unable to Connect to
(x.x.x.X). The client timed out waiting to connect to the Essbase Agent using TCP/IP.

Solution. Verify your TCP/IP address. Run the DSPESSENV INFO(*ALL) command in an Esshase
server library and check the second-level text of the Essbase/400 Server attributes error message.
Thiswill display the Essbase Server TCP/IP address.

Problem. The following error message is displayed: Error 1042017: The client or server timed out
waiting to receive data using TCP/IP.

Solution. Create or edit the NETDELAY & NETRETRYCOUNT settingsin the .cfg file to override the
default settings. The.cfg fileresidesin the Esshbase library on the server or in the/binfolder on your
PC (for example, ShowCase STRATEGY\bin). The file may reside on both the server and your PC.

NETDELAY dictates how long (in milliseconds) Essbase waits before retrying an unsuccessful
operation. The default is 200.

NETRETRYCOUNT dictates how many times the network triesto connect to the host. The default is
600.

Increase the values based on the frequency of the error (the more often the error occurs, the larger
the value). For example, increase the value of aless frequent error by hundreds; increase the value
of amore frequent error by thousands.

In addition, consider how many users experience the problem. If only afew users are affected,
changethe PCfile; if more users are affected, changethe i Seriesfile. After editing thefile, stop and
restart Esshase Server.
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Installing Essbase/400 Sample
Applications

When you install Essbase/400 Application Manager samples on your PC, the files required to
create the sample databases will be copied into the ShowCase STRATEGY\Client folder on your
hard drive. After a network installation, you can find the filesin the ShowCase STRATEGY\Client
folder on the network. After installation, you must create the sampl e applications and databases and
prepare them for use. This appendix explains these procedures.

Note: It is assumed that the samples and references to the sample applications in the Essbase/400
documentation set areinstalled from a server. However, the sampl e applications shipped with
Essbase/400 are installed from aclient PC. Therefore, be sure to specify the location of the
applications accordingly. In most cases, select the Location group box of agiven dialog box and
choose the Client option.

Essbase/400 includes six sample applications that can be installed on your server.
m Demo. Contains one database—Basic—referred to in the Essbase Technical Reference.
m Drinks. Contains one database—Demo—referred to in the Analyzer documentation.

m  Sample. Contains one database referred to throughout the Essbase/400 documentation set as
Basic. The spreadsheet user guides provide a step-by-step tutorial through the spreadsheet
clients.

m  Samppart. Thefirst of two applications designed to show the features of Essbase/400
partitioning. Samppart contains the Company database that is the target of a partitioned
database.

m  Sampeast. The second of two applications designed for Essbase/400 partitioning. Sampeast
contains an East database, the source of data for a partitioned database.

m  Scsample. Contains one database—Sales—referred to in the Query and Report Writer online
Help and tutorials.

Note: To use the Samppart and Sampeast applications, your Essbase/400 Server must be registered
with alicense number supporting partitioning.
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Creating the Sample Applications

This section explains how to set up the framework of Essbase/400 sample applications. The
following instructionsdo not load or cal culate the databases. For that information, see L oading and
Calculating the Sample Databases’ on p. 80.

Complete the following six steps for each application.

Make sure that you know:

m  The Essbase/400 Server is running

m Theserver's TCP/IP address

m A valid user ID and associated password

To connect to the Essbase/400 Server, from the Essbase/400 Application Manager menu, choose:

Server
Connect

The Connect dialog box requires the TCP/IP alias name or address, and a user ID and password.

To create a new application on the server, from the menus, choose:
File
New
Application

Give the application the appropriate sample name: Sample, Demo, Samppart, Sampeast, Drinks, Of
Scsample.

To create anew database for the application, choose:
File
New
Database

Name each database as follows:

Application name Database name

Sample Basic
Demo Basic
Samppart Company
Sampeast East
Drinks Demo
Scsample Sales

Move the sampl e database outline to the Essbase/400 Server. For instructions, see“Moving Objects
from the Client to Essbase/400 Server” on p. 75. In these instructions, for file type, select Outlines
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(.otl). Select the outline with the same name as the database that you’ re creating. See the following

table:

Application/database name  Outline name
Demo Basic Basic

Drinks Demo Demo
Sample Basic Basic
Samppart Company Company
Sampeast East East
Scsample Sales Sales

» To continue creating the sample databases, follow the instructions below for the appropriate
database:

Drinks Demo. L oad and calculate the Drinks Demo database by following the instructions under
“Drinks Demo” on p. 81.

Demo Basic. Move the report scripts of the Demo Basic database to Essbase/400 Server. For
instructions, see “Moving Objects from the Client to Essbase/400 Server” below. In these
instructions, for Files of Type, select Report Scripts (.rep). Repeat the instructions (opening and
saving) for al report scriptsin the folder.

Sample Basic. Move the rule objects of the Sample Basic database to Essbase/400 Server. For
instructions, see “Moving Objects from the Client to Essbase/400 Server” below. While
following theseinstructions, for Filesof Type, select Rule Objects (.rul). Repeat theinstructions
(opening and saving) for all rule objectsin the folder.

Samppart Company. Follow theinstructions in “ Setting Up the Environment for Samppart and
Sampeast” on p. 77, and then load and cal cul ate the database with theinstructionsin “ Samppart
Company” on p. 83.

Sampeast East. Follow thetasksin “ Setting Up the Environment for Samppart and Sampeast” on
p. 77, and then load and calcul ate the database with the instructionsin “ Sampeast East” on p. 84.

Scsample Sales. Move the rule object of the Scsample Sales database to Esshase/400 Server.
For instructions, see“Moving Objects from the Client to Essbase/400 Server” below. In these
instructions, for Files of Type, select Rule Objects (.rul) and select Textload.rul.

Moving Objects from the Client to Esshase/400 Server

This section helps you move outlines, calculation scripts, rule objects, and report scripts from the
client to Essbase/400 Server.

To move an outline, calculation script, rule object, or report script, you must complete all steps

in “Opening the Object” on p. 76 and “ Saving the Object” on p. 76 for each object.
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Opening

>

the Object

When opening an outlinefilein Application Manager, you may get an error message indicating that
long filenames are not supported. To solve this problem, move the client folder containing your
outlines, calculation scripts, report files, and rules files (for example, C:\Program Files\ShowCase
STRATEGY\Client\) to your root folder.

From the Essbase/400 Application Manager menu, choose:
File
Open
The Open Object dialog box appears.
In the Location group, select Client.

In the Application box, select the application for which you want to move an outline, calculation
script, rule object, or report script.

In the Database box, select the database for which you want to move an outline, calculation script,
rule object, or report script.

Click File System. The Open Client File dialog box appears.

Navigate to the folder in which you installed STRATEGY sample applications (for example,
C:\Program Files\ShowCase STRATEGY\Client\).

Click thefolder corresponding to the sample database that you' re creating: Demo, Drinks, Sampeast,
Sample, Samppart, Or Scsample.

In the Files of Type box, select thefiletype of the abject that you want to move: Outlines (.otl), Calc
Scripts (.csc), Rule Objects (.rul), Or Report Scripts (.rep).

Select the file to move and click Open.

Saving the Object

>

>

>

From the File menu, choose Save As. The Save Object dialog box appears.
In the Location group, select Server.

In the Server box, select the TCP/IP name or address of the server to which you want to move the
outline, calculation script, rule object, or report script.

In the Application box, select the application for which you are saving the outline, calculation
script, rule object, or report script.
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» In the Database box, select the database for which you are saving the outline, calculation script,
rule object, or report script.

» Inthe List Objects of Type box, select the appropriate object: Outlines, Calc Scripts, Rule Objects,
or Report Scripts.

» Inthe Object Name box, type the object name of the outline, calculation script, rule object, or
report script that you are saving.

» Click OK.

m |f Essbase/400 displays a message indicating that the object already exists and asks if you
would like to replace the existing object, click Yes.

m |f Esshase/400 displays a message indicating that the object is unlocked and asksif you would
like to replace the existing object, click Yes.

m |f Essbase/400 displays a message indicating that the object did not originate from the latest
version of the server and that you could lose dataand then asksif you want to continue, click Yes.

» Closethe appropriate window: outline viewer, calculation script editor, rule object editor, or report
script editor.

» Tofinish creating the Demo Basic, Drinks Demo, Sample Basic, or Scsample Sales databases, you
must load the data. The following tableindicates whereto find the instructions to load datainto the
sampl e database that you are creating.

Database name Reference

Demo Basic “Demo Basic” on p. 81
Drinks Demo “Drinks Demo” on p. 81
Sample Basic “Sample Basic” on p. 82

Scsample Sales “Scsample Sales’ on p. 85

Setting Up the Environment for Samppart and Sampeast

Essbase/400 includes two sampl e applications and databases that show the features of partitioning:
Samppart Company and Sampeast East. They include partition definitions stored in .ddb files.

The .ddb files define the map between member combinations in the target database (Company)
and the source database (East). For instructions on setting up partitions, see the Essbase Database
Administrator’s Guide. This guide also explains member combinations and the differences
between target and source databases.

For these applications to work in your environment, you must match or change the information
contained in the .ddb files. To use the applications, do the following:

m Create the user name that designed the applications.
m Change the server name embedded in the applications.

Note: Do not physically change the .ddb file information. Instead, complete the stepsin the
following sections. “ Creating the Partition User” describes how to create the user name so your
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users can use these applications. “ Changing the Server Name in Sample Partition Definitions’” on
p. 79 describes how to change the embedded server name to the name of your Essbase/400 Server.

Creating the Partition User
Because the Samppart and Sampeast applications were designed by a user called partitionuser, you
must create auser called partitionuser to work with these applications. Partitionuser must have
Application Designer access to these applications on the server where they are installed. If you are

unsure how to create a user and you use the Integrated Security feature of Essbase/400, see the
STRATEGY Administrator’s Guide. If you do not use Integrated Security, complete the following

steps:
» From the Essbase/400 A pplication Manager menu, choose:

Server
Connect

» Connect to the server with the Samppart and Sampesast applications. Log on as a user that has
supervisor privilege.

» From the Security menu, choose Users/Groups.

» Inthe User/Group Security dialog box, click the New User button to open the New User dial og box.
» Inthe Username box, enter partitionuser, using lowercase | etters.

» In the Password box, enter a password.

» In the Confirm Password box, type your password again.

» Click the App Access button to open the User/Group Application Access dialog box.

» Select the Sampeast application, and then select App Designer in the Access group box.

» Select the Samppart application, and then select App Designer in the Access group box.

» Double-click OK to return to the User/Group Security dialog box.

» Click Close.

» From the Server menu, choose Disconnect to log off of the server. Click OK.

» From the Server menu, choose Connect and log on as partitionuser. The Application Desktop

window appears. Y ou are ready to continue setting up the Samppart and Sampeast applications. See
“Changing the Server Name in Sample Partition Definitions’ on p. 79.
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Changing the Server Name in Sample Partition Definitions
The following steps change the embedded server name in the partition definition files (.ddb) to the

Essbase/400 Server name. The .ddb files shipped with Samppart and Sampeast are based on the
server name Localhost.

Note: You must complete the stepsin “Creating the Partition User” on p. 78 before continuing.
Changing the Server Name for the Samppart Company Database
The following steps change the server name in the Samppart Company .ddb file.
» Inthe Application Desktop window, select the Samppart application and Company database.

» From the Database menu, choose Partition Manager to open the Partition Manager dialog box.

Note: If the Partition Manager dialog box doesn’t appear or if it doesn’t contain definition entries,
contact your Essbase/400 system administrator. Your Essbase/400 Server must be registered with
alicense number that supports partitioning.

» Inthe Source Cube list, select the first definition entry—Localhost:Sampeast:East.

» Click Edit. The Dangling Remote Reference dial og box appears. Because you are not connected to
a server named Localhost, Essbase/400 is warning you before it allows you to edit the definition.

» Click Advanced. The Fix Dangling Partition Reference dialog box appears.
» Inthe Action group, select Correct the invalid partition reference.

» Inthe Reconnect group, in the Server text box, replace Localhost with the name of your
Essbase/400 Server (for example, ESSBASE).

» Click Apply. You are returned to the Partition Manager dialog box.

» In the Source Cube list, select the second definition entry—Localhost: Sampeast:East.
» Repeat the four steps beginning with “ Click Edit” and ending with “ Click Apply.”

» Inthe Target Cube list, select the first definition entry—Localhost: Sampeast:East.

» Repeat the four steps beginning with “Click Edit” and ending with “Click Apply.”

» From the Partition menu, choose Close to return to the Application Desktop window.

You have successfully changed the server name in the Samppart Company .ddb file.
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Changing the Server Name for the Sampeast East Database
The following steps change the server name in the Sampeast East .ddb file.
» Inthe Application Desktop window, select the Sampeast application and East database.
» From the Database menu, choose Partition Manager to open the Partition Manager dialog box.
» Inthe Source Cube list, select the first definition entry—Localhost:Samppart:Company.

» Click Edit. The Dangling Remote Reference dialog box appears. Because you are not connected to
a server named Localhost, Essbase/400 is warning you before it allows you to edit the definition.

» Click Advanced. The Fix Dangling Partition Reference dialog box appears.
» Inthe Action group, select Correct the invalid partition reference.

» Inthe Reconnect group, in the Server text box, replace Localhost with the name of your
Essbase/400 Server (for example, ESSBASE).

» Click Apply. You are returned to the Partition Manager dialog box.

» Inthe Source Cube list, select the first definition entry—Localhost:Samppart:Company.

» Repeat the four steps beginning with “Click Edit” and ending with “Click Apply.”

» Inthe Target Cube list, select the second definition entry—Localhost:Samppart:Company.
» Repeat the four steps beginning with “Click Edit” and ending with “Click Apply.”

» From the Partition menu, choose Close to return to the Application Desktop window.
You have successfully changed the server name in the Sampeast East .ddb file.

Note: When you have completed theinstructionsin “ Setting Up the Environment for Samppart and
Sampeast” on p. 77, you can continue buil ding the Samppart or Sampeast databases. See " Samppart
Company” on p. 83 or “Sampeast East” on p. 84.

Loading and Calculating the Sample Databases

Now that you've created the new application and database for the sample database and saved any
necessary rule files or report scripts on the server, you're ready to load the data into the database
and calculate it. The following sections will cover loading and calcul ating each sample database.
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Demo Basic

The Demo application contains one database called Basic. To prepareit for use, you must load and
calculate the data.

Note: When |oaded, the Demo Basic database uses approximately 2MB of disk space on the server,
in addition to the size of the data source file.

» From the Essbase/400 Application Manager menu, choose:

Server
Connect

» Connect to the server on which the Demo application isinstalled.

» Inthe Applications box, select Demo.

» Inthe Databases list, select Basic.

» From the Database menu, choose Load Data to open the Data Load dialog box.

» Click Find to locate adatafile to load. The Open Server Data File Objects dialog box appears.
» Inthe Location group, select Client.

» Make sure Text files is selected in the List Objects of Type box.

» Inthe Objectslist, select DATA.

» Click oK. The DataLoad dialog box is updated to display the datafile that you chose.

» Click OK to load the selected file. The datafile is approximately 660K B. It will take a minute or
two to load, and then the Data Load Completed dia og box appears.
» Click Close.

Once the dataisloaded into the database, Essbase/400 automatically commits the data to the disk.
You can safely stop the application or server and then restart it.

Drinks Demo

The Drinks application contains one database called Demo. To prepareit for use, you must load and
calculate the data

» From the Essbase/400 Application Manager menu, choose:

Server
Connect
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Connect to the server on which the Drinks application is installed.

In the Applications box, select DRINKS.

In the Databases list, select Demo.

From the Database menu, choose Load Data to open the Data L oad dial og box.

Click Find to locate adatafile to load. The Open Server Data File Objects dialog box appears.
In the Location group, select Client.

Make sure Text files is selected in the List Objects of Type box.

In the Objects list, select DATA.

Click OK. The Data L oad dialog box is updated to display the datafile that you chose.

Click OK to load the selected file. The datafile is approximately 3MB. It will take several minutes
to load, and then the Data Load Completed dialog box appears.

Click Close.
To calcul ate the database, from the Database menu, choose Calculate.
Select (Default) in the Calc Scripts list box and click OK.

Oncethe dataisloaded into the database, Essbase/400 automatically commits the data to the disk.
You can safely stop the application or server and then restart it.

Sample Basic

Thefirst databasein the Sample application is called Basic. To prepareit for use, you must load and
calculate the data.

Note: When loaded, the Sample Basic database uses approximately 5SMB of disk space on the server,
in addition to the size of the data sourcefile.

From the Essbase/400 Application Manager menu, choose:

Server
Connect

Connect to the server on which the Sample application isinstalled.
In the Applications box, select Sample.

In the Databases list, select Basic.
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» From the Database menu, choose Load Data to open the Data Load dial og box.

» Click Find to locate adatafile to load. The Open Server Data File Objects dialog box appears.
» Inthe Location group of the Open Server Data File Objects dialog box, select Client.

» IntheList Objects of Type box, be sure that Text files is selected.

» Inthe Objects list box, select CALCDAT.

» Click OK. The Data Load dialog box is updated to display the data file that you chose.

» Click OK to load the selected file. The datafileis approximately 3MB. It will take several minutes
to load, and then the Data L oad Completed dialog box appears.

» Click Close.

Once the dataisloaded into the database, Essbase/400 automatically commits the data to the disk.
You can safely stop the application or server and then restart it.

Samppart Company

After setting up the environment for the Samppart and Sampeast applications (as described in
“Providing User Access to the Sample Applications” on p. 86), you must load data into the
database of each application. This section explains how to load and calculate the Samppart
Company data.

Note: When loaded, the Samppart Company database uses approxi mately 2MB of disk space onthe
server, in addition to the size of the data sourcefile.

» From the Essbase/400 Application Manager menu, choose:

Server
Connect

» Connect to the server on which the Demo application isinstalled. Log on as partitionuser or asa
user with supervisor privilege.

» Inthe Applications box, select Samppart.

» Inthe Databaseslist, select Company.

» From the Database menu, choose Load Data to open the Data Load dial og box.

» Click Find to locate a datafile to load. The Open Server Data File Objects dialog box appears.
» Inthe Location group, select Client.

» Make sure Text files is selected in the List Objects of Type box.
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In the Objectslist, select CALCCOMP.
Click OK. The Data L oad dialog box is updated to display the datafile that you chose.

Click OK to load the selected file. The datafileisalarge, fully calculated data set. It should take
about a minute to load, and then the Data L oad Completed dialog box appears.
Click Close.

Oncethe datais|oaded into the database, Essbase/400 automatically commits the data to the disk.
You can safely stop the application or server and then restart it.

Sampeast East

After setting up the environment for the Samppart and Sampeast applications (as described in
“Providing User Accessto the Sample Applications” on p. 86), you must load datainto the database
of each application. This section explains how to load and calculate the Sampeast East data.

Note: When loaded, the Sampeast East database uses approximately 1.5MB of disk space on the
server, in addition to the size of the data source file.

From the Essbase/400 Application Manager menu, choose:

Server
Connect

Connect to the server on which the Demo application isinstalled. Log on as partitionuser or as a
user with supervisor privilege.

In the Applications box, select Sampeast.

In the Databases list, select East.

From the Database menu, choose Load Data to open the Data L oad dialog box.

Click Find to locate adatafile to load. The Open Server Data File Objects dialog box appears.
In the Location group, select Client.

Make sure that Text files is selected in the List Objects of Type box.

In the Objectslist, select CALCEAST.

Click oK. The Data L oad dialog box is updated to display the data file that you chose.

Click OK to load the selected file. The datafileisasmall, fully calculated data set. It should take
about a minute to load, and then the Data L oad Completed dialog box appears.

Click Close.
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Once the dataisloaded into the database, Essbase/400 automatically commits the data to the disk.
You can safely stop the application or server and then restart it.

Scsample Sales

The Scsample application contains one database called Sales. To prepareit for use, you must load
and calculate the data.

» From the Essbase/400 Application Manager menu, choose:

Server

Connect

» Connect to the server on which the Scsample application isinstalled.
» Inthe Applications box, select Scsample.
» Inthe Databaseslist, select Sales.
» From the Database menu, choose Load Data to open the Data Load dialog box.
» Click Find to locate adatafile to load. The Open Server Data File Objects dialog box appears.
» In the Location group, select Client.

» Click the File System button. The Open Client Data Files dialog box appears.

» Navigate to the C:\Program Files\ShowCase STRATEGY\Client\ folder and select the Scsample
folder.

» IntheFiles of Type box, verify that Text Files (.txt) is selected.

» Select DATA.txt and click OK. The Data L oad dialog box is updated to display the data file you that
chose.

» Select the Use Rules option and click the Find button bel ow the Use Rules option. The Open Server
Rules Object dialog box appears.

» Inthe Open Server Rules Object dialog box, verify the following options:
m  For Location, verify that Server is selected.

m  For Server, verify that the | P address of the Essbase/400 Server containing the Scsample
application is selected.

m For Application, verify that Scsample is selected.
m For Database, verify that Sales is selected.
m For List Objects of Type, verify that Rule Objects is selected.
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In the Objects box, select Textload and click OK to load the data. The datafile is approximately
430K B. It will take several minutesto load, and then the Data L oad Completed dialog box appears.

Click Close.
To calcul ate the database, from the Database menu, choose Calculate.

Select (Default) in the Calc Scripts list box and click OK.

Oncethe datais|oaded into the database, Essbase/400 automatically commits the data to the disk.
You can safely stop the application or server and then restart it.

Providing User Access to the Sample Applications

Essbase/400 provides a comprehensive security system for a secure multi-user environment. By
default, the sampl e applications are created with a security accesslevel of No Access, which means
no user can connect to the database without supervisor authority.

Thefirst user on the client is the user name defined when the Essbase/400 Server was installed.
This user automatically has supervisor privilege.

To provide all users with write access to the database:
From the Essbase/400 Application Manager menu, choose:

Server
Connect

Connect to the server on which the sample application isinstalled.

In the Applications box, select the sample application to which you want to grant access.
From the Application menu, choose Settings. The Application Settings dialog box appears.
In the Minimum Database Access group, select Write.

Click OK.

Repeat the above steps for each sample application to which you want to give your users access.

At this point, the Essbase/400 sample applications are ready for use. Next, create the appropriate
user IDs and security settings so that your users can log on to Essbase/400. For more information
on Essbase/400 security, see the STRATEGY Administrator’s Guide.
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